DNA Engine® Peltier Thermal Cycler

PTC-0200 DNA Engine Cycler

Operations Manual

Version 4.0
NOTICE TO PURCHASER

This base unit, Serial No. ____________, in combination with its immediately attached Bio-Rad sample block module(s), constitutes a thermal cycler whose purchase conveys a limited non-transferable immunity from suit for the purchaser’s own internal research and development and for use in applied fields other than Human In Vitro Diagnostics under one or more of U.S. Patents Nos. 5,656,493, 5,333,675, 5,475,610 (claims 1, 44, 158, 160-163 and 167 only), and 6,703,236 (claims 1-7 only), or corresponding claims in their non-U.S. counterparts, owned by Applera Corporation. No right is conveyed expressly, by implication or by estoppel under any other patent claim, such as claims to apparatus, reagents, kits, or methods such as 5’ nuclease methods. Further information on purchasing licenses may be obtained by contacting the Director of Licensing, Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California 94404, USA.

This DNA Engine thermal cycler, when combined with a Chromo4 detection module bearing a valid label license under U.S. Patent No. 6,814,934, constitutes a real-time thermal cycler licensed under U.S. Patent No. 6,814,934 and corresponding claims in any Canadian counterpart patent thereof owned by Applera Corporation, for use solely in research and all applied fields except human and veterinary in vitro diagnostics, provided that the real-time thermal cycler royalty fee that is applicable to said thermal cycler has been paid. No rights are conveyed expressly, by implication or estoppel to any patents on real-time methods, including but not limited to 5’ nuclease assays, or to any patent claiming a reagent or kit. For further information on purchasing license rights, contact the Director of Licensing at Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California, 94404, USA.

05434 rev E
Table of Contents

Explanation of Symbols ......................................................... iv
Safety Warnings ................................................................ iv
Safe Use Guidelines, Electromagnetic Interference, and FCC Warning .............. v
Documentation Conventions ....................................................... vi
The DNA Engine® Peltier Thermal Cycler
  Introduction ........................................................................ 1-1
  Layout and Specifications .................................................... 2-1
  Installation .......................................................................... 3-1
  Operation ........................................................................... 4-1
  Running Protocols ............................................................. 5-1
  Creating Programs ............................................................. 6-1
  Editing Programs ............................................................... 7-1
  Using the Utilities .............................................................. 8-1
  Networking ......................................................................... 9-1
  Maintenance ....................................................................... 10-1
  Troubleshooting ............................................................... 11-1
  The Remote Alpha Dock™ System ......................................... 12-1
Appendix A: Warranties ............................................................. A-1
Appendix B: Factory-Installed Protocols ............................................... B-1
Index ................................................................................... In-1
Declaration of Conformity ........................................................ DoC-1
Explanation of Symbols

CAUTION: Risk of Danger! Wherever this symbol appears, always consult note in this manual for further information before proceeding. This symbol identifies components that pose a risk of personal injury or damage to the instrument if improperly handled.

CAUTION: Risk of Electrical Shock! This symbol identifies components that pose a risk of electrical shock if improperly handled.

CAUTION: Hot Surface! This symbol identifies components that pose a risk of personal injury due to excessive heat if improperly handled.

Safety Warnings

Warning: Operating the DNA Engine® cycler before reading this manual can constitute a personal injury hazard. Only qualified laboratory personnel trained in the safe use of electrical equipment should operate these machines.

Warning: Do not open or attempt to repair the DNA Engine or any Alpha™ unit, or other DNA Engine accessory. Doing so will void your warranties and can put you at risk for electrical shock. Return the DNA Engine instrument to the factory (US customers) or an authorized distributor (all other customers) if repairs are needed.

Warning: All Alpha unit blocks can become hot enough during the course of normal operation to cause burns or cause liquids to boil explosively. Wear safety goggles or other eye protection at all times during operation.

Warning: The DNA Engine instruments incorporate neutral fusing, which means that live power may still be available inside the machines even when a fuse has blown or been removed. Never open the DNA Engine or DNA Engine Tetrad base; you could receive a serious electrical shock. Opening the base will also void your warranties.

Caution: Never remove an Alpha unit from the DNA Engine with the power turned on and a program running. Doing so can cause electrical arcing that can melt the contacts in the connector joining the Alpha unit to the DNA Engine.
Safe Use Guidelines

The DNA Engine instruments are designed to be safe to operate under the following conditions:

- Indoor use
- Altitude up to 2000 m
- Ambient temperature 5–31°C
- Maximum relative humidity 90%, noncondensing
- Transient overvoltage per Installation Category II, IEC 664
- Pollution degree 2, in accordance with IEC 664

Electromagnetic Interference

These devices comply with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) these devices may not cause harmful interference, and (2) these devices must accept any interference received, including interference that may cause undesired operation.

These devices have been tested and found to comply with the EMC standards for emissions and susceptibility established by the European Union at time of manufacture.

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications.

LE PRESENT APPAREIL NUMERIQUE N'EMET PAS DE BRUITS RADIOELECTRIQUES DEPASSANT LES LIMITES APPLICABLES AUX APPAREILS NUMERIQUES DE CLASS A PRESCRITES DANS LE REGLEMENT SUR LE BROUILLAGE RADIOELECTRIQUE EDICTE PAR LE MINISTERE DES COMMUNICATIONS DU CANADA.

FCC Warning

Warning: Changes or modifications to these units not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

This equipment qualifies as an “Exempted device” under Section 15.103(c) of the FCC Rules. Nonetheless, the design has been verified to comply within limits for Class “A” digital device.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radiofrequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.
Documentation Conventions

Typographic Conventions

The names of keyboard keys are set in double angle brackets:

Example  «Proceed»

Items in programming menus are italicized:

Example  Select *Edit* from the Main Menu.

Graphic Conventions

The programming screens displayed in the LCD window are represented by a box containing four lines of text:

Example

```
Run: 2-STEP
1= 92.0 for 0:05
Cycle: 1
Calc: 65.0
```

Terminology

A programming option is termed “selected” when the cursor is positioned in front of it. Use the «Select» keys (see fig. 2-2) to move the cursor. In some screens selected items are also displayed in all-capital letters.
Introduction

Meet the DNA Engine Thermal Cycler .................................................1-2
Using This Manual ...........................................................................1-2
Important Safety Information ...............................................................1-3
Meet the DNA Engine® Thermal Cycler

Thank you for purchasing a Bio-Rad PTC-0200 DNA Engine thermal cycler. Designed by a team of molecular biologists and engineers, the DNA Engine will meet your needs for a versatile, easy-to-use, reliable, and compact programmable thermal cycler.

- Interchangeable sample blocks—the Alpha™ unit family—that accommodate many types of tubes, microplates, and slides
- Hot Bonnet® heated lid (or its remote-controlled version, the motorized Moto Alpha™ Moto Alpha unit) for oil-free cycling
- Intuitive software with easy-to-read interface for quick and painless programming, editing, file management, password protection, and much more
- Choice of calculated sample temperature control for highest speed and accuracy, or block control for compatibility with protocols designed for a variety of instrument types
- Space-saving design for easy setup and transportation
- Instant Incubate feature for continuous-temperature incubations
- Networking of up to 15 machines, for convenient remote operation and documentation of runs
- Customizable factory-installed protocols

Using This Manual

This manual contains all the information you need to operate your DNA Engine safely and productively:

- Chapter 2 acquaints you with the **physical characteristics** of the DNA Engine.
- Chapters 3–5 present the basics of **installing and operating** the DNA Engine.
- Chapters 6 and 7 describe **programming** the DNA Engine.
- Chapter 8 outlines the **utilities** available for the DNA Engine.
- Chapter 9 describes how to **network and remotely operate** the DNA Engine.
- Chapter 10 explains the proper **maintenance** of the DNA Engine.
- Chapter 11 offers **troubleshooting** information for the DNA Engine.
Important Safety Information

Safe operation of the DNA Engine begins with a complete understanding of how the machine works. Please read this entire manual before attempting to operate the DNA Engine. Do not allow anyone who has not read this manual to operate the machine.

The DNA Engine can generate enough heat to inflict serious burns and can deliver strong electrical shocks if not used according to the instructions in this manual. Please read the safety warnings and guidelines at the front of this manual, and exercise all precautions outlined in them.
Layout and Specifications

Front View .............................................................. 2-2
Control Panel ............................................................ 2-2
Back View ............................................................... 2-3
Bottom View ............................................................ 2-3
Alpha Units .............................................................. 2-4
  Single-Block Models ............................................... 2-4
  Dual-Block Models .................................................. 2-4
  Slide Block .......................................................... 2-4
  Moto Alpha Unit ..................................................... 2-4
Specifications ......................................................... 2-5
Gradient Specifications ............................................... 2-6
Front View

(Figure 2-1)

Alpha™ unit, lid closed
Thumbwheel
Air intake vents
Control panel
Air exhaust vents (also on other side)

Control Panel

(Figure 2-2)

Block key
Block status lights
Instant incubation key
Power light
LCD window
Left and right selection keys
Proceed key
Cancel key
Back View

(Figure 2-3)

Bottom View

(Figure 2-4)
Alpha Units

Single-Block Models

60V Alpha unit: Holds 60 x 0.5 ml tubes

96V Alpha unit: Holds 96 x 0.2 ml tubes or one 96-well microplate

384 Alpha unit: Holds one 384-well microplate or one 96-well microplate

Dual-Block Models

30/30 Dual Alpha™ unit: Holds 2 x 30 x 0.5 ml tubes

30/48 Dual Alpha unit: Holds 1 x 30 x 0.5 ml tubes and 1 x 48 x 0.2 ml tubes

48/48 Dual Alpha unit: Holds 2 x 48 x 0.2 ml tubes or half plates

Slide Block

Slide Chambers™ Alpha unit: Holds 2 x 16 standard slides

Moto Alpha™ unit

Permits remote control of Alpha unit lid opening; available in 96-well, 384-well, and flat-block formats.
## Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Thermal range:</strong></td>
<td>–5°C to 105°C, but no more than 30°C below ambient temperature (4°C to 100°C for the Slide Chambers Alpha unit)</td>
</tr>
<tr>
<td><strong>Thermal accuracy:</strong></td>
<td>±0.3°C of programmed target at 90°C, NIST-traceable</td>
</tr>
<tr>
<td><strong>Thermal uniformity:</strong></td>
<td>±0.4°C well-to-well within 30 seconds of arrival at 90°C (for most Alpha units; see specifications for individual Alpha units)</td>
</tr>
<tr>
<td><strong>Ramping speed:</strong></td>
<td>Up to 3°C/sec for all single- and dual-block Alpha units; up to 1.2°C/sec for the Slide Chambers Alpha unit.</td>
</tr>
<tr>
<td><strong>Sample capacity:</strong></td>
<td>Varies with installed Alpha unit</td>
</tr>
<tr>
<td><strong>Line voltage:</strong></td>
<td>DNA Engine® cycler: 100–240 VAC rms (no adjustment needed among voltages within these ranges)</td>
</tr>
<tr>
<td><strong>Frequency:</strong></td>
<td>50–60 Hz single phase</td>
</tr>
<tr>
<td><strong>Power:</strong></td>
<td>DNA Engine cycler: 850 W maximum</td>
</tr>
<tr>
<td><strong>Fuses:</strong></td>
<td>Two 6.3 A, 250 V, 5 x 20 mm</td>
</tr>
<tr>
<td><strong>Displays:</strong></td>
<td>One 20 x 4 LCD alphanumeric display</td>
</tr>
<tr>
<td><strong>Ports:</strong></td>
<td>One 25-pin 8-bit parallel interface printer port</td>
</tr>
<tr>
<td></td>
<td>One 9-pin RS-232 serial port for printer or remote use</td>
</tr>
<tr>
<td></td>
<td>One IEEE-488 bidirectional general purpose interface bus</td>
</tr>
<tr>
<td><strong>Memory:</strong></td>
<td>400 typical programs in up to 12 individual folders</td>
</tr>
</tbody>
</table>
Gradient Specifications (96V Alpha module only)

**Accuracy:** +0.3°C of programmed target at end columns, 30 seconds after the timer starts for the gradient step, NIST–traceable

**Column uniformity:** +0.4°C, well–to–well within column, within 30 seconds of reaching target temperature

**Gradient calculator accuracy:** +0.4°C of actual well temperature

**Lowest programmable temp:** 30°C

**Highest programmable temp:** 105°C
3 Installation

Packing Checklist ................................................................. 3-2
Setting Up the DNA Engine Cycler .............................................. 3-2
Environmental Requirements .................................................... 3-2
Power Supply Requirements ...................................................... 3-3
Air Supply Requirements .......................................................... 3-3
  Ensuring an Adequate Air Supply ............................................ 3-3
  Ensuring That Air Is Cool Enough .......................................... 3-4
Requirements for Robotics Installations ..................................... 3-4
Packing Checklist

After unpacking the DNA Engine® cycler, check to see that you have received the following:

- One DNA Engine base
- One Alpha™ unit (more if additional units were ordered)
- Two spare fuses
- One power cord
- DNA Engine Peltier Thermal Cycler, Operations Manual (this document)

If any of these components are missing or damaged, contact Bio-Rad or the authorized distributor from whom you purchased the DNA Engine cycler to obtain a replacement. Please save the original packing materials in case you need to return the DNA Engine cycler for service. See appendix A for warranty information.

Setting Up the DNA Engine Cycler

The DNA Engine cycler requires only minimal assembly: plugging in the power cord and inserting an Alpha unit. Insert the power cord plug into its jack at the back of the machine (see fig. 2-3 for location of jack), then plug the cord into an electrical outlet. With the machine turned off, insert an Alpha unit (see “Installing an Alpha Unit,” chapter 4).

Caution: Do not insert or remove an Alpha unit with the DNA Engine cycler turned on; electrical arcing can result. Read the safety warning at the front of this manual regarding electrical safety when inserting or removing an Alpha unit.

Environmental Requirements

Ensure that the area where the DNA Engine cycler is installed meets the following conditions, for reasons of safety and performance:

- Nonexplosive environment
- Normal air pressure (altitude below 2000 m)
- Ambient temperature 5–31°C
- Relative humidity up to 90%
- Unobstructed access to air that is 31°C or cooler (see below)
• Protection from excessive heat and accidental spills (Do not place the DNA Engine cycler near such heat sources as radiators, and protect it from danger of having water or other fluids splashed on it, which can cause shorting in its electrical circuits.)

Power Supply Requirements

The DNA Engine cycler requires 100–240 VAC, 50–60 Hz, and a grounded outlet. The DNA Engine cycler can use current in the specified range without adjustment, so there is no voltage-setting switch.

Power cords for outlets other than the US 120V outlet may be purchased from computer stores, since they are also used for most desktop computers and printers and meet international standard IEC-320. The power cord must be rated to carry at least 10 A at 125 V or 250 V, depending on the voltage available in your nation. The quality of the power cord can be further ensured by making certain it is inscribed with the trademark of UL, CSA, TUV, VDE, or another national testing agency.

Note: Do not cut the supplied 120 V power cord and attach a different connector. Use a one-piece molded connector of the type specified above.

Air Supply Requirements

The DNA Engine cycler requires a constant supply of air that is 31°C or cooler in order to remove heat from the Alpha unit’s heat sink. Air is taken in from vents at the front, back, and bottom of the machine and exhausted from vents on both sides (see figs. 2-1, 2-3, and 2-4). If the air supply is inadequate or too hot, the machine can overheat, causing performance problems, software error messages (particularly “HS Overheating” and “Slow Block Cycling”), and even automatic shutdowns. Special attention should be paid to airflow and air temperature in robotics installations of DNA Engine cyclers.

Ensuring an Adequate Air Supply

• Do not block the air intake vents.

Position the DNA Engine cycler at least 10 cm from vertical surfaces and other thermal cyclers (greater distances may be required; see below). Do not put loose papers under the machine; they can be sucked into the air intake vents on the bottom of the machine.

• Do not allow dust or debris to collect in the air intake vents.

The bottom air vents are particularly liable to collect dust and debris, sometimes completely clogging up. Check for dust and debris every few months, and clean the intake vents as needed. Remove light collections of dust with a soft-bristle brush or damp cloth. Severe collections of dust and debris should be vacuumed out. Turn the machine off prior to cleaning or vacuuming air vents.
Ensuring That Air Is Cool Enough

- Do not position two or more DNA Engine cyclers (or other thermal cyclers) so that the hot exhaust air of one blows directly into the air intake vents of another.

- Make sure the DNA Engine cycler receives air that is 31°C or cooler by measuring the temperature of air entering the machine through its air intake vents.

Place the DNA Engine cycler where you plan to use it, and turn it on. Try to reproduce what will be typical operating conditions for the machine in that location, particularly any heat-producing factors (e.g., nearby equipment running, window blinds open, lights on). Run a typical protocol (e.g., 2-Step) for 30 minutes to warm up the DNA Engine cycler, then measure the air temperature at the back air intake vents. If more than one machine is involved, measure the air temperature for each.

If the air intake temperature of any machine is warmer than 31°C, use table 3-1 to troubleshoot the problem. Some experimentation may be required to determine the best solution when more than one cause is involved. After taking steps to solve the problem, verify that the temperature of the air entering the air intake vents has been lowered, using the procedure outlined above.

Requirements for Robotics Installations

Robotics installations require special attention to airflow and air temperature. Typically in these installations, DNA Engine cyclers and other thermal cyclers are crowded into a small area, along with other heat-generating equipment. Overheating can quickly occur when many of these machines are operating at once, unless preventive measures are taken.

Follow the procedures described above to ensure adequate airflow and an air intake temperature of 31°C or cooler. Air intake temperature must be verified by measurement.

Do not use oil to thermally couple sample vessels to the blocks of machines in a robotics installation. Oil makes plates difficult to remove.

Table 3-1 Troubleshooting Air Supply Problems

<table>
<thead>
<tr>
<th>Cause</th>
<th>Possible Remedies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air circulation is poor.</td>
<td>Provide more space around machine or adjacent room ventilation.</td>
</tr>
<tr>
<td>Ambient air temperature is high.</td>
<td>Adjust air conditioning to lower ambient air temperature.</td>
</tr>
<tr>
<td>Machine is in warm part of room.</td>
<td>Move machine away from, or protect machine from, such heat sources as radiators, heaters, other equipment, or bright sunlight.</td>
</tr>
<tr>
<td>Machines are crowded.</td>
<td>Arrange machines so that warm exhaust air does not enter intake vents.</td>
</tr>
</tbody>
</table>
4 Operation

Turning the DNA Engine Cycler On .............................................. 4-2
Understanding the Main Menu ................................................. 4-2
Using the Control Panel ......................................................... 4-3
  Operation Keys ..................................................................... 4-3
  Status Indicator Lights .......................................................... 4-3
Using the Data Ports ............................................................... 4-3
Operating Alpha Units ............................................................. 4-4
  Installing an Alpha Unit .......................................................... 4-4
  Removing an Alpha Unit ........................................................ 4-5
  Opening an Alpha Unit .......................................................... 4-5
  Closing an Alpha Unit ........................................................... 4-5
Selecting the Correct Sample Vessel ....................................... 4-6
  0.5ml Tubes ....................................................................... 4-6
  0.2ml Tubes ....................................................................... 4-6
  Microplates .......................................................................... 4-6
  Thin-Walled Vs. Thick-Walled Tubes .................................... 4-6
Sealing Sample Vessels ......................................................... 4-7
  Sealing with Oil or Wax .......................................................... 4-7
  Sealing with the Hot Bonnet Lid ............................................. 4-7
  Adjusting the Hot Bonnet Lid’s Pressure .............................. 4-8
Loading Sample Vessels into the Block ................................... 4-9
  Using Oil to Thermally Couple Sample Vessels to the Block .... 4-10
Appendix 4-A: Tube, Microplate, and Sealing System Selection Chart .......... 4-11
Appendix 4-B: Safety Warning Regarding Use of 35S Nucleotides ............ 4-12
Turning the DNA Engine® Cycler On

Move the power switch to “1” (the “On” position). The fan will turn on and the power light on the keyboard will glow red. In most cases a self-test of the heat pumps will begin running (see note below). Its progress is tracked on a screen in the LCD window:

![](PTC-200.png)

This screen disappears in 1 minute. If a problem is detected, the display shows an error message.

**Note:** If the Alpha™ unit’s block or heat sink is not at ambient temperature (typically because the Alpha unit was recently in use), the machine will skip the self-test.

If the self-test does not detect any problems, the Main Menu is displayed:

![](PTC-200.png)

The DNA Engine cycler is now ready to execute programs.

Understanding the Main Menu

The Main Menu is the common access point to all programming and machine configuration screens.

- **Run:** Executes a program.
- **Enter:** Allows new programs to be entered.
- **List:** Accesses utilities that display or print a program’s steps.
- **Edit:** Allows modification of stored programs.
- **Files:** Accesses file management utilities.
- **Setup:** Accesses machine and networking configuration screens.
Using the Control Panel

The control panel (see fig. 2-2) includes operation keys, status indicator lights, an LCD window for displaying programming and machine status text, and a numeric keypad for entering values into programs.

Operation Keys

- **Select keys** (left and right arrows): Move the cursor one space or option to the left or right in the LCD window; during a protocol run, display time and cycle information.
- **Proceed**: Accepts a selected menu or screen option; during a protocol run, advances the program to its next step.
- **Cancel**: Terminates a running protocol; during program creation or editing, cancels the last entry.
- **Stop**: Terminates a running protocol.
- **Pause**: Pauses a protocol during execution; accesses Japanese Katakana syllabary.
- **Instant Incubate**: Initiates a program that sets up the DNA Engine cycler as a simple incubator.
- **Block**: Selects a different block when using a Dual Alpha™ unit; switches between block screens and the Main Menu in the LCD window during a protocol run.

Status Indicator Lights

- **Power light**: Glows red when the DNA Engine cycler is powered up.
- **Block Status lights**: Indicate which blocks are in use; glow red when blocks are heating and green when blocks are cooling.

Using the Data Ports

The DNA Engine cycler has three data ports located at the rear of the machine: an RS-232 port, an IEEE-488 port, and a parallel (printer) port. See chapters 8 and 9 for information on using these ports to network machines, connect them to a computer, or print data.
Operating Alpha Units

**Note:** Operation of the Slide Chambers™ Alpha unit will not be discussed, owing to the many differences between this type of Alpha unit and the others. Please see the *Slide Chambers Operations Manual* for operating instructions.

**Note:** Moto Alpha™ units are installed and removed as described below. See the *Moto Alpha Unit Operations Manual* for instructions on opening and closing Moto Alpha units.

Installing an Alpha Unit

1. **Turn the DNA Engine cycler off** (see the Caution on p. 4-5).
2. Hold the Alpha unit at its front and back edges.
3. Lower the Alpha unit into the DNA Engine base, leaving at least 3cm between the front edge of the Alpha unit and the front of the base.
4. Raise the handle at the back of the Alpha unit, and slide the block forward as far as it will go (fig. 4-1A).
5. Push the handle down until it is completely vertical (fig. 4-1B); firm pressure may be required. A definite click signals that the Alpha unit’s connectors have mated with the DNA Engine cycler’s connectors.

When the handle is in the down position, the Alpha unit is locked into place.
Removing an Alpha Unit

1. **Turn the DNA Engine cycler off** (see the Caution below).

2. Pull upward on the handle. When the lock releases, you will hear a click, and the Alpha unit will slide a little toward the back of the DNA Engine cycler. The electrical connectors of the Alpha unit and the DNA Engine cycler are now disengaged, so there is no danger of electrical shock.

3. Slide the Alpha unit toward the rear of the DNA Engine cycler about 3 cm.

4. Grasp the front and back edges of the Alpha unit, and lift it out of the machine.

⚠️ **Caution:** Do not insert or remove an Alpha unit with the DNA Engine cycler turned on; electrical arcing can result. Read the safety warning at the front of this manual regarding electrical safety when inserting or removing an Alpha unit.

Opening an Alpha Unit

Grip the front edge of the top lever of the Hot Bonnet® lid as shown in figure 4-2A, and pull upward firmly. The top lever will pop open to reveal the entire thumbwheel (fig. 4-2B). Continue pulling upward to open the Hot Bonnet lid. The Hot Bonnet lid will tip backward, revealing the entire block.

⚠️ **Caution:** Do not pull on the thumbwheel to open the unit. This can damage the Hot Bonnet lid's closing mechanism.

Closing an Alpha Unit

Press down on the top lever. The lever will close down over the thumbwheel as the Hot Bonnet lid closes down over the sample block. A click signifies that the Hot Bonnet lid’s latch has engaged.

---

Figure 4-2  Opening an Alpha unit.
Selecting the Correct Sample Vessel

The DNA Engine cycler’s wide variety of interchangeable Alpha units affords you great scope in choosing sample vessels. Keep in mind that differences in tube and plate composition and wall thickness among the many brands available can affect reaction performance. Protocols may require some adjustment to ensure optimum performance when using a new vessel type. Bio-Rad offers a full range of tubes and microplates, manufactured to the specifications of each type of Alpha unit to ensure a precise fit. See chapter appendix 4-A for a complete list.

0.5 ml Tubes

Make sure thick-walled 0.5 ml tubes fit the wells snugly. Since these tubes were originally designed for centrifuges, some brands may not fit tightly in thermal cycler wells. Thin-walled 0.5 ml tubes were specifically designed for thermal cycling, and the higher quality brands provide a good and consistent fit. Bio-Rad provides thin- and thick-walled 0.5 ml tubes designed for precise block fit.

0.2 ml Tubes

All types of thin-walled 0.2 ml tubes may be used. Bio-Rad sells high-quality 0.2 ml tubes in a number of styles, including individual tubes and strips.

Microplates

A variety of 96-well polycarbonate or polypropylene microplates can be used in 96-well Alpha units as long as they fit the wells snugly. Polypropylene microplates are usually preferred because they exhibit very low protein binding and, unlike polycarbonate microplates, do not lose water vapor through the vessel walls. This allows smaller sample volumes to be used — as little as 5–10 µl. Polypropylene microplates and compatible sealing systems are available from Bio-Rad. (See “Sealing Sample Vessels” on the next page for a description of available sealing systems from Bio-Rad.)

Thin-Walled Vs. Thick-Walled Tubes

The thickness of sample tubes directly affects the speed of sample heating and thus the amount of time required for incubations. Thick-walled tubes delay sample heating, since heat transfers more slowly through the tubes’ walls. For the earliest types of thermal cyclers this delay mattered little. These machines’ ramping rates were so slow (below 1°C/sec) that there was plenty of time for heat to transfer through the tube wall to the sample, during a given incubation.

Modern thermal cyclers have much faster ramping rates (up to 2–3°C/sec), so the faster heat transfer provided by thin-walled tubes allows protocols to be significantly shortened. On average, about 30 seconds can be saved per cycle by using thin-walled tubes, for an overall savings of 15 minutes in a 30-cycle run.
Sealing Sample Vessels

To avoid changing the concentration of reactants, steps must be taken to prevent the evaporation of water from reaction mixtures during thermal cycling. Only a layer of oil or wax will completely prevent evaporation from the surface of the reaction fluid. However, an adequate degree of protection can be achieved by sealing vessels with caps, film, adhesive seals, or mats, then cycling the samples using the heated lid to prevent condensation.

Sealing with Oil or Wax

Mineral oil, silicone oil, paraffin wax, or Chill-out™ liquid wax may be used to seal samples. Use only a small amount of oil or wax; 1–3 drops (15–50µl) are usually sufficient. (Include this volume in the total volume when setting up a calculated-control protocol; see “Choosing a Temperature Control Mode” in Chapter 5.) **Use the same amount of oil or wax in all sample vessels to ensure a uniform thermal profile.**

Most paraffin waxes solidify at room temperature. The wax can then be pierced with a micropipette and the samples drawn off from below the wax. Silicone oil and mineral oil can be poured off or aspirated from tubes if the samples are first frozen (–15° to –20°C). The samples are usually pure enough for analysis without an extraction.

Chill-out liquid wax (available from Bio-Rad) is an easy-to-use alternative to oil. This purified paraffinic oil solidifies at 10°C and is liquid at room temperature. By programming a hold at low temperature, the wax can be solidified at the end of a run. A pipette tip can then be used to pierce the wax in the tubes and remove the samples. The wax is available in a clear, optical-assay grade or dyed red to assist in monitoring its use. The red dye has no adverse effects on fluorescent gel analysis of reaction products.

Sealing with the Hot Bonnet Lid

The Hot Bonnet lid’s heated inner surface maintains the air in the upper part of sample vessels at a higher temperature than the reaction mixture. This prevents condensation of evaporated water vapor onto the vessel walls and lid, so that solution concentrations are unchanged by thermal cycling. The Hot Bonnet lid also exerts pressure on the tops of vessels loaded into the block, helping to maintain a vapor-tight seal and to firmly seat tubes or the plate in the block.

Caps, film, adhesive seals, or mats must be used along with the Hot Bonnet lid to prevent evaporative losses.

**Note:** When tubes are cooled to below-ambient temperatures, a ring of condensation may form in tubes above the liquid level but below the top of the sample block. This is not a cause for concern since it occurs only at the final cool-down step, when thermal cycling is complete.
DNA Engine Operations Manual

Microseal® ‘A’ film offers a quick alternative to sealing microplates or arrays of tube strips. This film is specially designed to seal tightly during cycling, yet release smoothly to minimize the risk of aerosol formation and cross-contamination of samples. Microseal ‘A’ film is easily cut for use with fewer than 96 samples.

Microseal ‘B’ adhesive seals feature an aggressive adhesive, effective from –20°C to 110°C, which allows secure sample storage or transport before and after cycling. The clear polyester backing allows easy inspection of sample wells. Microseal ‘B’ clear, adhesive seals are ideal for thermal cycling in all polypropylene and polystyrene microplates.

Microseal ‘F’ aluminized foil acts as a barrier against evaporation from –20°C to 105°C. It is thin enough to pierce with a pipet tip for recovery of sample from individual wells.

96-well PCR plate sealing mats (223-9442) are an economical means to seal 96-well microplates. An array of 96 dimples on the mat helps orient it on the microplate and prevents the mat from sticking to the heated lid. The mats may be cleaned with sodium hypochlorite (bleach) for reuse, and they are autoclavable.

Microseal ‘P’/‘P+’ pads are designed for use in applications such as cycle sequencing, in which several successive runs may be sealed with the same pad. Use ‘P’ pads with the original version of Power Bonnet™ lids (ALP-1296 and ALP-1238) and use ‘P+’ pads with the newer-design Moto Alpha™ units (ALP-2296, ALP-2238, ALP-2200, and ALP-2201).

Adjusting the Hot Bonnet Lid’s Pressure

The pressure exerted by the inner lid of the Hot Bonnet lid must be manually adjusted to fit the sample vessels being used in a given reaction. Once set, the Hot Bonnet lid can be opened and closed repeatedly without readjustment as long as neither the tube or microplate type nor the sealing method changes. Any change in vessel type or sealing method requires readjustment of the Hot Bonnet lid.

Follow these steps to adjust the pressure exerted by the Hot Bonnet inner lid:

1. Make sure the block’s wells are clean. Even tiny amounts of extraneous material can interfere with the proper seating of a microplate or tubes, which would prevent the inner lid from exerting uniform pressure on the loaded microplate or tubes.

2. Open the Hot Bonnet lid. Turn the green thumbwheel all the way counterclockwise to completely raise the inner lid.

3. Load either a microplate or at least eight individual tubes into the sample block. The inner lid pivots around a central point, so it is important to distribute individual tubes evenly. Load at least four tubes in the center of the block and at least one tube in each of the four corners of the block. If using a sealing film or mat, apply it to the loaded microplate according to the manufacturer’s directions.
4. Close the Hot Bonnet lid by pressing down on the top lever. Turn the thumbwheel clockwise to lower the Hot Bonnet inner lid onto the loaded microplate/tubes. The thumbwheel turns easily at first since the inner lid has not yet come into contact with anything. Stop turning the thumbwheel when you feel increased resistance, which indicates that the inner lid has touched the microplate/tubes.

5. Open the Hot Bonnet lid. Turn the thumbwheel clockwise an extra half to three-quarters of a turn to set an appropriate lid pressure.

⚠️ Caution: Do not turn the thumbwheel more than three-quarters of a turn. This can make it hard or impossible to close the lid and puts excessive strain on the latch holding the lid closed.

An extra half to three-quarters of a turn ensures the correct pressure for most types of reaction vessels. Some empirical testing may be required to determine the optimum pressure required for certain vessels. Once this pressure has been determined, the thumbwheel position that delivers it may be marked with a colored marking pen or piece of tape.

Note: As an aid in gauging how much the thumbwheel has been turned, mark it at the quarter turn positions, or every sixth bump on the thumbwheel (there are 24 total bumps).

6. Close the Hot Bonnet lid.

Loading Sample Vessels into the Block

When using a small number of tubes, they should all be placed in the center of the block, to ensure uniform thermal cycling of all samples. Also load at least one empty tube in each corner of the block, to ensure that the Hot Bonnet lid exerts even pressure on the sample tubes (see “Adjusting the Hot Bonnet Lid Pressure,” above).

To ensure uniform heating and cooling of samples, sample vessels must be in complete contact with the block. Adequate contact is ensured by always doing the following:

- Ensure that the block is clean before loading samples. (See chapter 10 for cleaning instructions.)
- Firmly press individual tubes or the microplate into the block wells.
Using Oil to Thermally Couple Sample Vessels to the Block

With two exceptions (see below), Bio-Rad does not recommend using oil to thermally couple sample vessels to the block, for the following reasons:

- Calculated-control protocols do not run accurately when oil is used.
- Oil traps dirt, which interferes with thermal contact between vessels and the block.

⚠️ Caution: If you use oil in the block, use only mineral oil. Never use silicone oil. It can damage the Alpha unit.

One exception to this recommendation involves the use of volatile radioactive $^{35}$S nucleotides. A small amount of oil in the block can help prevent escape of these compounds. See chapter appendix 4-B for important information regarding safe use of these compounds in polypropylene tubes and polypropylene and polycarbonate microplates. A second exception involves the use of thick-wall 0.5 ml tubes. Certain brands of these tubes fit poorly in the block, in which case oil may somewhat improve thermal contact. Whenever possible, use high-quality thin-wall tubes intended for thermal cycling. (See chapter appendix 4-A for a tube and plate selection chart.)
# Appendix 4-A

## Tube, Microplate, and Sealing System Selection Chart

**Key**

4 Reaction vessel fits block/sealing option fits reaction vessel without modification.

# Reaction vessel/sealing option can be cut to fit.

<table>
<thead>
<tr>
<th>Bio-Rad Thermal Cycler Blocks</th>
<th>Reaction Vessels</th>
<th>Sealing Options for Oil-Free Cycling</th>
</tr>
</thead>
<tbody>
<tr>
<td>384</td>
<td>HSP-series</td>
<td>Microseal 'A' film MSA-5001</td>
</tr>
<tr>
<td>96 (0.2ml)</td>
<td>MSP-series</td>
<td>Microseal 'B' seal MSB-1001</td>
</tr>
<tr>
<td>48 (0.2ml)</td>
<td>MSP-series</td>
<td>Microseal 'F' foil MSF-1001</td>
</tr>
<tr>
<td>60/30 (0.5ml)</td>
<td>MSP-series</td>
<td>Sealing mat 223-9442</td>
</tr>
<tr>
<td>4</td>
<td>MSP-series</td>
<td>Microseal 'P' pad MSP-1001</td>
</tr>
<tr>
<td></td>
<td>MSP-series</td>
<td>Microseal 'P+' pad** MSP-1002</td>
</tr>
<tr>
<td></td>
<td>MSP-series</td>
<td>Strip caps TCS-series</td>
</tr>
<tr>
<td></td>
<td>MSP-series</td>
<td>Chill-out wax CHO-series</td>
</tr>
</tbody>
</table>

### Bio-Rad Catalog #

- HSP-series
- MSP-series
- MSB-series
- MSF-series
- MLL-series

### Description

- Hard-Shell® skirted 384-well microplates
- Microseal® skirted 384-well microplates
- Hard-Shell skirted 96-well microplates
- Microseal skirted 96-well microplates
- Multiplate™ unskirted 96-well microplates
- Multiplate™ unskirted 48-well microplates
- Multiplate™ unskirted 25-well microplates
- Multiplate™ unskirted 24-well microplates
- Concord™ skirted 96-well microplates
- 0.2ml strip tubes 8/strip & 12/strip
- 0.2ml individual tubes
- 0.5ml individual tubes, w/caps

### Sealing Options

- Microseal 'A' film MSA-5001
- Microseal 'B' seal MSB-1001
- Microseal 'F' foil MSF-1001
- Sealing mat 223-9442
- Microseal 'P' pad MSP-1001
- Microseal 'P+' pad** MSP-1002
- Strip caps TCS-series
- Chill-out wax CHO-series

* "Concord” microplates are made from polycarbonate plastic, which is prone to poor sealing and vapor leakage during stringent thermal cycling.

** Since plates may adhere tightly to the Microseal 'P+' pad, this seal is only recommended for use with the Moto Alpha™ motorized unit, which has the ability to hold the plate in the block.
Appendix 4-B

Safety Warning Regarding Use of
\textit{\textsuperscript{35}S} Nucleotides

Some researchers have experienced a problem with radioactive contamination when using \textit{\textsuperscript{35}S} in thermal cyclers. This problem has occurred with all types of reaction vessels.

The Problem

When \textit{\textsuperscript{35}S} nucleotides are thermally cycled, a volatile chemical breakdown product forms, probably \textit{SO\textsubscript{2}}. This product can escape the vessel and contaminate the sample block of a thermal cycler, and possibly the air in the laboratory. Contamination has been reported with microassay plates, 0.2 ml tubes, and 0.5 ml tubes.

96-Well Polycarbonate Microplates

These microplates present the largest risk of contamination. Polycarbonate is somewhat permeable both to water and the \textit{\textsuperscript{35}S} breakdown product. This problem is exacerbated when polycarbonate plates are held at high temperatures for long periods of time, or when the plates are sealed for oil-free thermal cycling.

0.2 ml Polypropylene Tubes and 96-Well Polypropylene Microplates

These tubes are manufactured with very thin walls to enhance thermal transfer. The thin walls are somewhat fragile and can “craze” or develop small cracks when subject to mechanical stress. Undamaged thin polypropylene tubes may also be somewhat permeable to the \textit{\textsuperscript{35}S} breakdown product. Either way, there have been reports of \textit{\textsuperscript{35}S} passing through the walls of 0.2 ml tubes of several different brands during thermal cycling. No data are yet available on radioactive contamination with polypropylene microplates.

0.5 ml Polypropylene Tubes

Contamination problems are rarer with this type of tube, but instances have been reported.

The Solution

1. Substitute the low-energy beta emitter \textit{\textsuperscript{33}P} in cycle sequencing. \textit{\textsuperscript{33}P} nucleotides are not subject to the same kind of chemical breakdown as \textit{\textsuperscript{35}S} nucleotides, and they have not been associated with volatile breakdown products.

2. If \textit{\textsuperscript{35}S} must be used, three things will help control contamination: an oil overlay inside the tubes, mineral oil in the thermal cycler outside the tubes, and use of thick-walled 0.5ml tubes. Always run \textit{\textsuperscript{35}S} thermal cycling reactions in a fume hood, and be aware that vessels may be contaminated on the outside after thermal cycling. Please be certain that you are using the appropriate detection methods and cleaning procedures for this isotope. Consult your radiation safety officer for his or her recommendations.
If mild cleaning agents do not remove radioactivity, harsher cleaners may be used. Users have suggested the detergent PCC-54 (Pierce Chemical Co., Rockford, Illinois; Pierce Eurochemie B.V., Holland), Micro Cleaning Solution (Cole-Parmer, Niles, Illinois), and Dow Bathroom Cleaner (available in supermarkets).

Caution: Harsh cleaning agents are corrosive to aluminum and must never be used on bare aluminum blocks. Bio-Rad Alpha unit blocks are anodized, so they have a protective coating of aluminum oxide. Still, harsh agents (such as those above) must be thoroughly rinsed away within a few minutes of application, or the anodization will degrade.
Running Protocols

Running a Protocol ................................................................. 5-2
  Choosing a Stored Protocol to Run ................................. 5-2
  Choosing a Block to Run the Protocol On ......................... 5-3
  Setting Up the Temperature Control Method ...................... 5-3
    Setting Up a Block-Control Protocol .............................. 5-3
  Setting Up a Calculated-Control Protocol ......................... 5-4
Reading the Runtime Screen ................................................ 5-5
  Switching Between the Runtime Screen and the Main Menu ........ 5-6
Reading the Protocol Completion Screen ............................. 5-6
Printing a Log for a Running Program ................................. 5-6
Manually Stepping Through a Protocol .................................. 5-7
Pausing a Running Protocol .................................................. 5-7
Stopping a Running Protocol ................................................ 5-8
Resuming a Protocol after a Power Outage ........................... 5-8
Using the Instant Incubation Feature ................................. 5-9
Running a Protocol

Running a protocol on the DNA Engine® cycler involves three steps:

1. Choosing a stored protocol to run.
2. Choosing a block to run it on, if a Dual Alpha™ unit is installed.
3. Setting up the temperature control method.

Either a custom-designed protocol or one of the factory-installed resident protocols may be run. See appendix C for descriptions of the resident protocols, which may be edited to fit your needs (see chapter 7). All the factory-installed protocols are stored in a single folder, called the <MAIN> folder, at the time of shipping.

Choosing a Stored Protocol to Run

With the Main Menu displayed, select Run, then press «Proceed». One of two types of screen will be displayed, depending on whether custom protocols have been stored in the <MAIN> folder or in custom folders:

• If all protocols have been stored in the <MAIN> folder:

The first of three or more screens listing the protocols will be displayed. Custom protocols are listed first, then the 14 factory-installed programs:

```
Run: <MAIN>  _CUSTOM1 CUSTOM2 QUIKSTEP 2-STEP 3-STEP EXTEND
```

Use the «Select» keys to scroll through the listed protocols. Scroll past the last- or first-listed protocol to see the next screen down or up. Select the desired protocol, then press «Proceed».

• If custom protocols have been stored in one or more custom folders:

One or more screens listing all the folders residing in the machine will be displayed:

```
Run: _<MAIN> <FOLDER>  <FOLDER2> <FOLDER3>
```

Select the folder that contains the protocol, then press «Proceed». One or more screens listing the protocols stored in the folder will be displayed. Use the «Select» keys to scroll through the listed protocols. Select the desired protocol, then press «Proceed».
In either instance, after you press «Proceed», a screen similar to the following example will be displayed:

```
Run: 2-STEP
Vessel Type: _TUBES   Plate
```

The top line of the screen will identify the selected protocol (2-STEP in the example). The other lines on the screen will request information needed to set up the temperature control method (explained below).

### Choosing a Block to Run the Protocol On

If a Dual Alpha unit is installed (or if networked Alpha units are available; see chapter 9), one of the blocks must be designated to run the protocol. The first available block is automatically designated when a protocol is chosen. Press «Block» to choose a different block. The selected block's letter is identified in the upper right-hand corner of the screen:

```
Run: 2-STEP on A
Vessel Type: _TUBES   Plate
```

The status indicator light for the selected block will flash green.

### Setting Up the Temperature Control Method

When the protocol is selected (and the correct block is designated for a Dual Alpha unit), one or more screens will be displayed. These screens will ask for information needed to set up the block's temperature control method. The DNA Engine cycler can control the block's temperature in two different ways: **block control** or **calculated control**. Chapter 6 explains in detail how these methods work and their implications for protocol design. The following describes how to respond to the screens that are displayed for each control method. When these screens have been dealt with, the protocol will begin to run.

#### Setting Up a Block-Control Protocol

A single screen asking about use of the heated lid will be displayed:

```
Run: ICEBUCKET
Use heated lid?
Yes _NO
```

Select Yes or No, then press «Proceed». The protocol will begin running.
Setting Up a Calculated-Control Protocol

Three screens will be presented:

- A screen asking for sample vessel information:

  Run: 2-STEP  
  Vessel Type:  
  _TUBES  Plate

Select from the options shown (may include tubes, plates, and slides), then press «Proceed». Choose Plate for polycarbonate microplates and Tube for polypropylene tubes or polypropylene microplates. For blocks that hold only tubes, choose Thin or Thick, depending on the type of tube loaded.

**Note:** See “Using Calculated Control” in the *Slide Chambers Alpha Unit Operations Manual* for information on specifying slide format.

- A screen asking for the sample reaction volume (last line in example below):

  Run: 2-STEP  
  Vessel Type: TUBES  
  Volume (mL): 10

Use the keypad to enter a sample volume in microliters, then press «Proceed». If sample vessels are sealed with oil or wax, include the volume of the oil or wax in the total sample volume entered.

**Note:** Specify 10 µl for any volume less than 10 µl.

**Note:** Verify that your vessel sealing system is adequately tight before performing 5 µl reactions.

- A screen asking about use of the heated lid. Select Yes or No, then press «Proceed». The protocol will begin running.
Reading the Runtime Screen

During a protocol run, a runtime screen will be displayed:

Run: 2-STEP
1= 92.0 for 0:05
Cycle: 1
Calc: 68.0

The screen lists the protocol name (2-STEP in the example above), protocol step that is running (1), cycle number (1), method of temperature control (Calc), and the block temperature for block-control protocols, and the calculated sample temperature for calculated-control protocols (68.0°C). When the step’s target temperature is reached, a timer begins running in the lower right-hand corner of the screen. The first digit is the minutes elapsed; the two digits after the colon are the seconds elapsed.

For protocols using calculated control, press the left «Select» key to display the block’s temperature on the third line of the screen:

Run: 2-STEP
1= 92.0 for 0:05
Block: 62.1
Calc: 68.0

This screen shows only as long as the left «Select» key is pressed. The runtime screen returns when you stop pressing the key.

Press the right «Select» key to see a screen listing the cycle number (if a GoTo step is executing), time elapsed so far for the protocol run, and estimated remaining time left in the run:

Run: 2-STEP
Cycle: 1
Total time: 0:20
Est remain: 1:01:51

This screen is also displayed only as long as the key is pressed. The runtime screen returns when you stop pressing the key.
Switching Between the Runtime Screen and the Main Menu

Press «Block» to toggle between the runtime display and the Main Menu. This allows you to edit a stored program, enter a new one, print a program, run another protocol on a dual-block Alpha unit or networked DNA Engine cycler, or use the file utilities, while the protocol runs.

Reading the Protocol Completion Screen

When the protocol run finishes, a long beep sounds, and a notification screen is displayed:

```
Run: 2-STEP
PROGRAM COMPLETE
Total time: 50:31
```

Certain error messages may also be displayed in this screen (see chapter 11). Press «Proceed» to return to the Main Menu.

Printing a Log for a Running Protocol

If the DNA Engine cycler is connected to a printer, you can print a log for the run that includes:

- The DNA Engine cycler’s serial number and software version
- The protocol’s name
- The temperature control method for the protocol
- A list of the protocol’s steps
- The runtime thermal data

To print a runtime protocol log, first ensure that a printer is connected to the machine. See “Printing a Program,” chapter 8, for information about compatible printers.

Follow the instructions under “Choosing a Printer Port,” chapter 8, to prepare the DNA Engine cycler to communicate with your printer.

As long as a printer is connected to the machine, the following screen will appear whenever a protocol is run:

```
Run: 2-STEP
Printer output?
_Yes  No
```
To print the protocol as it runs, select Yes, then press «Proceed».

**Note:** If no printer is connected to the machine, the screen allowing you to select printer output is not displayed at all.

### Manually Stepping Through a Protocol

Once a protocol is running, pressing «Proceed» gives you the option of immediately advancing the protocol to the next programmed step, even if the machine is currently ramping the block's temperature (see chapter 6 for information on ramping). A confirmation screen will be displayed:

```
Run: 2-STEP
Go on to next step?
    _YES  No
```

Select Yes, then press «Proceed». The protocol will advance to its next step.

### Pausing a Running Protocol

Press «Pause» to temporarily stop a running program. The timer in the lower right-hand corner of the runtime screen will be replaced by the word “Pause”:

```
Run: 2-STEP
  l=  92.0  for 0:05
Cycle:  1
Calc:  92  PAUSE
```

The samples are held at the displayed temperature until either the «Pause» or the «Proceed» key is pressed, which causes the protocol run to resume.

A protocol cannot be paused before the target temperature for a given step has been reached. If «Pause» is pressed before this point, the block continues heating or cooling until the target is reached, and then the protocol is paused.
Stopping a Running Protocol

Press either «Stop» or «Cancel» to stop a running protocol. A cancellation confirmation screen will be displayed:

```
Run: 2-STEP
Stop 2-STEP?
         Yes  _NO
```

Select Yes, then press «Proceed» to cancel the protocol. The total run time for the protocol will be displayed:

```
Run: 2-STEP
       PROGRAM CANCELED
Total time: 1:15
```

Press «Proceed» to return to the Main Menu.

**Note:** Turning off the machine does not stop a running protocol. The DNA Engine cycler will assume the protocol was stopped by a power outage and will resume running the protocol when the machine is turned back on (see below).

Resuming a Protocol after a Power Outage

If a power failure occurs when a protocol is running, the DNA Engine cycler will hold the protocol in memory for a minimum of 24 hours to a maximum of 7 days, depending on environmental conditions.

When power is restored, the protocol will begin running again at the point at which it was stopped, and a notice about the power interruption will be displayed. The notice will identify the step and the cycle that were running when the power failure occurred, and the block’s temperature at the time power was restored:

```
Run: 2-STEP
       A/C POWER FAILED
Cycle 1  Step 1
Recovered at 20.2
```

Press «Proceed» to remove this screen. The protocol’s runtime screen will immediately be displayed.
Using the Instant Incubation Feature

The DNA Engine cycler may be converted to a constant-temperature incubator by pressing «Instant Incubate». A screen allowing use of the heated lid will be displayed:

**INCUBATE:**

Use heated lid?
Yes  _No

Use the «Select» keys to enable or disable the heated lid, then press «Proceed». A screen allowing entry of the incubation temperature will be displayed.

**INCUBATE:**

1=  20.0 for ever
Use heated lid?
Yes  _No

Use the keypad to enter any incubation temperature from –5.0° C to 105.0° C, then press «Proceed». The DNA Engine cycler will incubate the sample at the specified temperature until «Cancel» or «Stop» is pressed.

When the sample block reaches the incubation temperature, a timer begins running in the lower right-hand corner of the screen. To stop and start the timer, press «Pause».

4 **Tip:** The Pause feature is useful if you need to temporarily remove samples that must be incubated for a precise period of time. Pausing the timer while samples are not in the block allows you to track the exact duration of their incubation.
Creating Programs

The Elements of a Program .......................................................... 6-2
Designing a New Program ......................................................... 6-3
  Translating a Protocol into a Program ....................................... 6-3
  Using the GoTo Step to Write Short Programs ......................... 6-3
  Choosing a Temperature Control Method ................................. 6-4
    Calculated Control ............................................................. 6-4
    Block Control ........................................................................ 6-4
  Modifying Block-Control Programs for Calculated Control .......... 6-5
  Modifying a Program Designed for a Different Machine .............. 6-5
Entering a New Program ............................................................ 6-5
  Initiating the Program ............................................................ 6-5
  Naming the Program ............................................................... 6-6
  Choosing a Temperature Control Method .................................. 6-6
  Entering the Program’s Steps .................................................... 6-6
  Entering a Temperature Step ..................................................... 6-7
  Entering a Gradient Step .......................................................... 6-8
  Editing a Gradient Step ............................................................ 6-10
  Reviewing a Gradient Program .................................................. 6-10
  Using the Gradient Calculator ................................................... 6-11
  Entering a Ramp Step ............................................................... 6-12
  Entering a GoTo Step ............................................................... 6-13
  Entering the End Step .............................................................. 6-14
Modifying a Program Step with the Options .............................. 6-15
  Entering an Increment Option .................................................... 6-15
  Entering an Extend Option ........................................................ 6-16
  Entering an Beep Option ............................................................ 6-17
Revising During Programming ................................................... 6-18
  To Change the Last Value Entered or Menu Option Chosen ........ 6-18
  To Change All the Values in the Step Being Entered .................. 6-18
  To Change Values for Earlier Steps in the Program .................... 6-18
Deleting a Program ................................................................. 6-19
Keeping a Permanent Record of Programs ................................. 6-19
The Elements of a Program

DNA Engine® cycler programs consist of a series of steps encoding a protocol. These steps are run using one of two possible temperature control methods: calculated control or block control.

Programs may contain five types of steps. Two of the steps are mandatory, and three are optional:

1. **Temperature step (mandatory):** Sets a temperature for the block and the length of time it is held at that temperature. The DNA Engine cycler brings the block to this temperature at its maximum rate of heating or cooling, unless modifying instructions are added to the program. (The maximum rate of heating and cooling is up to 3°C/sec for all single- and dual-block Alpha™ units; 1.2°C/sec for the Slide Chambers™ Alpha unit.)

2. **Gradient step (optional):** Allows you to program a temperature gradient across the sample block. The range of any single gradient can be as great as 24°C from left to right. The maximum programmable temperature is 105°C; the minimum programmable temperature is 30°C.

3. **Ramp step (optional):** Sets a slower-than-maximum rate of heating or cooling.

4. **GoTo step (optional):** Causes the program to cycle back to an earlier step for a specified number of times (up to 9,999 times).

5. **End step (mandatory):** Instructs the DNA Engine cycler to shut down its heat pump because the program is complete.

Additional instructions, termed options, can be added to certain program steps to modify their effects:

1. **Increment:** Modifies a temperature step to allow a progressive increase or decrease of temperature (0.1–10.0°C per cycle) each time the step is executed in a cycle. This is useful in “touchdown” programs, when the annealing temperature of an oligonucleotide is not known.

2. **Extend:** Modifies a temperature step to allow progressive lengthening or shortening of a temperature step hold (by 1–60 sec/cycle) each time a step is executed in a cycle. This is useful for accommodating an enzyme with diminishing activity.

3. **Beep:** Modifies a temperature step or ramp step to make the machine beep when the target temperature is reached.
Designing a New Program

Translating a Protocol into a Program

Until you are completely familiar with programming the DNA Engine cycler, you may find it helpful to first translate the protocol into DNA Engine cycler program steps and options on paper. Write down the protocol to be programmed, one step per line. Then write the type of program step that goes with the protocol steps, at the end of each line. If a protocol step involves an option as well as a program step, write both names down on the same line. Finally, write the End step at the bottom of the list; programs will not run without this step. Number the lines 1 through N, where N is the final, End line.

Using the GoTo Step to Write Short Programs

The GoTo step allows programs of many repetitious steps to be shortened to just a few lines. When the program encounters a GoTo step, it returns to a specified step, repeats that step, and repeats all steps that follow, back to the GoTo step. When the program has returned, or cycled, back to the step a specified number of times, the program moves on to the step that follows the GoTo step.

For example, consider a basic cycle sequencing protocol consisting of 30 repeats of a denaturation, and an annealing/extension step. Rather than listing all 60 steps, use a GoTo step to design a short, easy-to-enter program:

<table>
<thead>
<tr>
<th>Raw program:</th>
<th>DNA Engine program:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. 92° for 30 sec</td>
</tr>
<tr>
<td>1. 92° for 30 sec</td>
<td>2. 92° for 30 sec</td>
</tr>
<tr>
<td>2. 60° for 3 min</td>
<td>2. 60° for 3 min</td>
</tr>
<tr>
<td>3. 92° for 30 sec</td>
<td>3. GoTo step 1, 29 times (i.e.,</td>
</tr>
<tr>
<td>4. 60° for 3 min</td>
<td>cycle back to step 1 and repeat</td>
</tr>
<tr>
<td>5. 92° for 30 sec</td>
<td>steps 1 and 2, 29 times)</td>
</tr>
<tr>
<td>6. 60° for 3 min</td>
<td>5. End</td>
</tr>
<tr>
<td>7. 92° for 30 sec</td>
<td></td>
</tr>
<tr>
<td>[continues for total of 60 lines]</td>
<td></td>
</tr>
</tbody>
</table>
Choosing a Temperature Control Method

The DNA Engine cycler can control block temperature in two possible ways, each of which has different implications for the speed and accuracy of sample heating:

- **Calculated control**: The DNA Engine cycler adjusts the block’s temperature to maintain samples of a specific volume in a specific vessel type at programmed temperatures. This includes optimized overshoots of the block by a few degrees for a few seconds, which bring the samples to the programmed temperatures.

- **Block control**: The DNA Engine cycler adjusts the block’s temperature to maintain the block at programmed temperatures, independent of sample temperature.

**Calculated Control**

Calculated control is the method of choice for most types of programs, yielding the most consistent, most reliable, and fastest programs. When using calculated control, the DNA Engine cycler maintains a running estimate of sample temperatures based on the block’s thermal profile, the rate of heat transfer through the sample tube or slide, and the sample volume or mass (this information about the samples is provided when a program is run; see “Setting Up the Temperature Control Method,” chapter 5). Since this estimate is based on known quantities and the laws of thermodynamics, sample temperatures are controlled much more accurately than with block or probe control.

Hold times can be shortened significantly when protocols are run under calculated control. In addition to the simple convenience of spending less time running reactions, shorter protocols also help preserve enzyme activity and minimize false priming. Cycling denaturations run under calculated control are usually optimal at 5 seconds. Annealing/extension steps can also be shortened, but the periods for these will be reaction specific.

Calculated control provides for shorter protocols in three ways:

1. Brief and precise block temperature overshoots are used to bring samples to temperature rapidly.
2. Incubation periods are timed according to how long the samples, not the block, reside at the target temperature.
3. The machine automatically compensates for vessel type and reaction volume.

**Block Control**

Block control provides less accurate control of sample temperatures than calculated control provides. Under block control, the temperature of samples always lags behind the temperature of the block. The length of the time lag depends on the vessel type and sample volume but typically is between 10 and 30 seconds. Block control is chiefly used to run protocols developed for other thermal cyclers that use block control.
Modifying Block-Control Programs for Calculated Control

Block-control programs can be changed to calculated control by subtracting at least 15–20 seconds from each temperature step. Some empirical testing may be required to adjust modified programs for optimum performance.

Modifying a Program Designed for a Different Machine

The ramp programming step can be used to adapt programs designed for thermal cyclers with slower maximum heating and cooling rates than the DNA Engine cycler. In addition, a given protocol will occasionally work better with a slower rate of temperature change; the ramp step can be used to optimize the program for such a protocol.

Entering a New Program

Programming the DNA Engine cycler moves through five steps:

1. Initiating the program
2. Naming the program
3. Choosing a temperature control method
4. Entering the program’s steps
5. Entering the End step

Each step involves entering values from the keyboard or making selections from a menu. Programs may be edited as they are being entered.

Programs are automatically saved when the End step is entered. They are stored in the <MAIN> folder unless folders have been created for them.

Initiating the Program

To initiate a new program, select Enter from the Main Menu, then press «Proceed». A naming screen will be displayed:
Naming the Program

Name the program an eight-character word consisting of any combination of letters (Roman and Greek), numbers, punctuation marks, or Japanese Katakana.

Press the right «Select» key to scroll forward and the left «Select» key to scroll backward through the alphabets and characters available, which are presented in this order: Roman alphabet, selected Greek letters, punctuation marks, numbers. To access the Japanese Katakana syllabary, press the «.» key. A second press of «.» returns the machine to Western characters.

When the character needed is displayed next to Name, press «Proceed». The character will be accepted, and the cursor will move one space to the right. Numbers and dashes may also be inserted by pressing the corresponding keys on the keypad.

When the name is complete, press «Proceed» once to accept the last character and again to accept the whole name. If the name is already in use for a program, a screen saying “Name In Use” will be displayed. If this happens, press «Proceed», then enter a different name.

Choosing a Temperature Control Method

When the name has been entered (“CUSTOM1” is used in the following and all succeeding examples), a screen requesting selection of a temperature control method will be displayed:

Enter: CUSTOM1
Control method:
   Block   Probe
   _CALCULATED

Select a control method, then press «Proceed».

Entering the Program’s Steps

When a temperature control method has been chosen, the Enter Menu will be displayed:

Enter: CUSTOM1
Step 1= _TEMP
   Gradient
   Ramp   End
Use this menu to enter each step of the program:

- **Temp** enters a temperature step.
- **Gradient** enters a Gradient step.
- **GoTo** enters a GoTo step (note: since a protocol cannot begin with a GoTo step, GoTo does not appear on the initial Enter Menu).
- **Ramp** enters a ramp step.
- **End** enters the End step.

### Entering a Temperature Step

To enter a temperature step, select Temp from the Enter Menu, then press «Proceed». The first Temp screen will be displayed:

```
Enter: CUSTOM 1
1=
Temp C: _
```

The second line of this screen shows the number of the step being programmed (1 is used in the example above). The last line of the screen allows a target temperature (in degrees Celsius) to be entered for the step.

Use the keyboard to enter any number between –5.0 and 105.0 as the target temperature (92.0 is used in the example below):

```
Enter: CUSTOM 1
1=
Temp C: 92.0
```

Press «Proceed». The target temperature will move to the second line of the screen, and a line allowing a hold time to be entered for the step will be displayed:

```
Enter: CUSTOM 1
1= 92.0
Time: _
```
Enter the hold time for the step (30 seconds is used in the example below):

<table>
<thead>
<tr>
<th>Enter:</th>
<th>CUSTOM 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>l=</td>
<td>92.0</td>
</tr>
<tr>
<td>Time:</td>
<td>30</td>
</tr>
</tbody>
</table>

**Note:** If a hold time of zero (0) is entered, the DNA Engine cycler will hold the block at the target temperature indefinitely.

Press «Proceed». The hold time will move to the second line of the screen, and a confirmation menu will be displayed on the last line:

<table>
<thead>
<tr>
<th>Enter:</th>
<th>CUSTOM 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>l=</td>
<td>92.0 for 0:30</td>
</tr>
<tr>
<td>OK?:</td>
<td>_YES No Option</td>
</tr>
</tbody>
</table>

Select one of the displayed choices, then press «Proceed»:

- **Yes** accepts the step and displays the Enter Menu again. Use the Enter Menu to enter the next step in the program.
- **No** allows reentry of the target temperature and hold time for the step.
- **Option** displays the Options Menu (see “Modifying a Program Step with the Options,” p. 6-15).

4 **Tip:** Avoid programming many short holds of only a few seconds each. This can overheat the block, causing the “HS Overheating” or “PS Overheating” error messages to be displayed and triggering automatic Alpha unit shutdowns if the block exceeds its maximum allowable temperature.

**Entering a Gradient Step**

When you reach the step at which a gradient is desired, select **Gradient** from the Enter Menu and then press the «Proceed» key. For the purpose of this example the step in which the gradient will be entered shall be Step 2:
Creating Programs

The gradient screen will appear:

```
Enter: CUSTOM 1
Lower Temp C:
```

Enter the lower limit temperature (for the purposes of this example, 50°), then press «Proceed». The upper temperature screen will appear:

```
Enter: CUSTOM 1
  50.0
Upper Temp C:
```

Enter the upper temperature (for the purposes of this example, 70°), then press «Proceed». (Use integers only; decimals are not accepted).

The next screen requires you to enter a hold time for the temperature gradient step:

```
Enter: CUSTOM 1
  2= 50.0 to 70.0
Time:
```

Enter the hold time in the form of min:sec. Press «Proceed». A confirmation screen will appear:

```
Enter: CUSTOM 1
  2= 50.0 to 70.0
for 0:30
OK? Yes No Option
```

Select “Yes” to enter the step into memory and proceed to the next step; select “No” to reject or edit the current step. To preview, select Option, then Preview. Preview gives the predicted temperatures for each of the wells along the sample block’s long axis. (The lines do not all appear in the display; use the «Select» keys to scroll up or down.)

```
Gradient Preview:
Column 1- 50.0 left
Column 2- 51.8
Column 3- 53.6
```
Editing a Gradient Step

To edit a gradient step, select Edit from the Main Menu. The program will be displayed as follows:

![List: CUSTOM 1
1= 92.0 for 0:20
2= 50.0 to 70.0 for 0:30]

Use the «Select» keys to scroll to the step you want to edit.

Reviewing a Gradient Program

After the protocol has been run, the Program Complete screen will be displayed. Press the «Proceed» key, and the next screen will display a review of the gradient well temperatures:

Gradient Review:

Column 1- 50.0 left
Column 2- 50.5
Column 3- 51.5
Column 4- 53.2
Column 5- 55.5
Column 6- 58.4
Column 7- 61.8
Column 8- 64.6
Column 9- 66.8
Column 10- 68.4
Column 11- 69.6
Column 12- 70.0 right

Scroll up and down the screen using the «Select» keys. When scrolling the “Gradient Review” line will be held constant while the lower 3 lines can be manipulated up or down. The temperatures displayed will be for each of the twelve wells along the long-axis of the sample block. These temperatures will be predicted from an algorithm as a steady-state temperature of the block and the sample. You may then return to the Main Menu by pressing the «Proceed» key.
Using the Gradient Calculator

The gradient calculator predicts, for a given gradient, the temperatures for each of the twelve wells along the long-axis of the sample block. These temperatures will be predicted from an algorithm as a steady-state temperature of the block and the sample. To use the gradient calculator, select the List command from the Main Menu and then press the «Proceed» key. You will see a List screen:

```
List:
Programs
_GRADIENT CALCULATOR
```

Select Gradient Calculator and press the «Proceed» key:

```
Lower Temp C: 50.0
Upper Temp C: 70.0
```

Enter lower limit temperature of the gradient using the number keys and then press the «Proceed» key. Enter the upper temperature for the gradient using the number keys and «Proceed» key. You may enter integers without decimal points. The following screen will be displayed:

```
Gradient Calculator:
Column 1-  50.0  left
Column 2-  50.5
Column 3-  51.5
Column 4-  53.2
Column 5-  55.5
Column 6-  58.4
Column 7-  61.8
Column 8-  64.6
Column 9-  66.8
Column 10- 68.4
Column 11 -  69.6
Column 12- 70.0  right
```

You may scroll up and down the screen using the «Select» keys. When scrolling, the “Gradient Calculator” line will be held constant while the lower 3 lines can be manipulated up or down.
Entering a Ramp Step

To enter a ramp step, select Ramp from the Enter Menu. The first Ramp screen will be displayed:

```
Enter: CUSTOM1
3=
Rate  C / s: _
```

The second line of this screen shows the number of the step being programmed (3 is used in the example above). The last line of the screen allows a ramp rate (in degrees Celsius per second) to be entered for the step.

Use the keyboard to enter any rate up to 2.5°C/sec (1°C/sec is used in the example below):

```
Enter: CUSTOM1
3=
Rate  C / s: 1
```

**Note:** If a ramp rate faster than the Alpha unit’s maximum rate of heating and cooling is entered, the maximum rate will be used.

Press «Proceed». The ramp rate will move to the second line of the screen, and a line allowing entry of a finish temperature for the ramp step will be displayed:

```
Enter: CUSTOM1
3= 2.0 /s
Finish temp: _
```

Enter the finish temperature for the ramp step (69°C is used in the example below):

```
Enter: CUSTOM1
3= 2.0 /s
Finish temp: 69
```

Press «Proceed». The finish temperature will be moved to the second line of the screen, and a confirmation menu will be displayed on the last line:

```
Enter: CUSTOM1
3= 2.0 /s to 60.0
OK? _YES  No  Option
```
Select one of the displayed choices, then press «Proceed»:

- **Yes** accepts the step and displays the Enter Menu again. Use the Enter Menu to enter the next step in the program.
- **No** allows reentry of the ramp rate and finish temperature.
- **Option** displays the Options Menu (see “Modifying a Program Step with the Options,” p. 6-11).

**Tip:** A ramp step will not hold the block at its finish temperature. Instead, as soon as finish temperature is reached, the next step of the program will immediately be executed. To hold the block for some period of time at a ramp step’s finish temperature, make sure a temperature step immediately follows the ramp step, and program the hold at the finish temperature into this step.

### Entering a GoTo Step

To enter a GoTo step, select GoTo from the Enter Menu. The first GoTo screen will be displayed:

```
Enter: CUSTOM 1
5=GoTo
GoTo step: 
```

The second line of this screen shows the number of the step being programmed (5 is used in the example above). The last line of the screen allows entry of the number of the step the program should cycle back to.

Enter the number of the step the program should cycle back to (1 is used in the example below):

```
Enter: CUSTOM 1
5=GoTo
GoTo step: 1
```

Press «Proceed». The step number will move to the second line of the screen, and a line allowing an additional number of cycles to be entered will be displayed:

```
Enter: CUSTOM 1
3=GoTo 1
Addtl cycles: 
```
Enter the additional number of times the program should cycle back to the step (3 is used in the example below):

```
Enter: CUSTOM 1
3=GoTo 1
Addtl cycles: 3
```

Press «Proceed». The number of additional cycles will move to the second line of the screen, and a confirmation menu will be displayed on the last line:

```
Enter: CUSTOM 1
3=GoTo 1, 3 times
OK? _YES  No
```

Select one of the displayed choices, then press «Proceed»:

- **Yes** accepts the step and displays the Enter Menu again. Use the Enter Menu to enter the next step in the program.
- **No** allows reentry of the step number and number of additional cycles.

**Entering the End Step**

To enter the End step, select *End* from the Enter Menu. The single End screen will be displayed:

```
Enter: CUSTOM 1
4=End
OK? _YES  No
```

This screen automatically enters “End” on the second line of the screen, next to a step number, and displays a confirmation menu for the step on the last line of the screen.

Select one of the displayed choices, then press «Proceed»:

- **Yes** accepts the step, stores the program, and displays the Main Menu.
- **No** displays the Enter Menu so that additional steps can be added.
If you have created custom folders for your programs (see chapter 8), choosing Yes brings up a screen listing the folders:

```
Save Program in:
<MAIN>  <FOLDER>
<FOLDER2>
```

Select the folder you want to store the program in, then press «Proceed». The program will be stored in the folder, and the Main Menu will be displayed.

**Modifying a Program Step with the Options**

The Options Menu is accessible from the confirmation menus of temperature steps and ramp steps. To access the Options Menu, select *Option* from the confirmation menu of a temperature or ramp step, then press «Proceed». The Options Menu will be displayed on the bottom line of the screen:

```
Enter: CUSTOM 1
l= 92.0  for 0:30
Option: _INC Ext Beep
```

- **Inc** modifies a temperature step with an increment option. An increment option allows a progressive increase or decrease of temperature each time the step is executed in a GoTo cycle.
- **Ext** modifies a temperature step with an extend option. An extend option allows a progressive lengthening or shortening of hold times each time the step is executed in a GoTo cycle.
- **Beep** modifies a temperature step or a ramp step, causing the machine to beep when a specified target temperature is reached.

**Entering an Increment Option**

To enter an increment option, select *Inc* from the Options Menu for a temperature step, then press «Proceed». The first Inc screen will be displayed:

```
Enter: CUSTOM 1
l= 92.0  for 0:30
+  
C / cycle:  + _
```
The temperature step being modified appears on the second line of this screen. The plus sign on the third line means that the screen is set up to enter a progressive increase in temperature per cycle. Press «→» to switch to a minus sign, allowing entry of a progressive decrease in temperature. Press «Cancel» to change back to a plus sign.

Enter the numerical value of the temperature increase or decrease (1.2 is used in the example below):

```
Enter: CUSTOM 1
1= 92.0  for 0:30
+ 1.2  per cycle
OK? _YES  No  Option
```

Press «Proceed». The Inc value just entered will move to the third line of the screen, and a confirmation menu will be displayed on the last line:

```
Enter: CUSTOM 1
1= 92.0  for 0:30
+ 1.2  per cycle
OK? _YES  No  Option
```

Select one of the displayed choices, then press «Proceed»:

- **Yes** accepts the Inc value and displays the Enter Menu again. Use the Enter Menu to enter the next step in the program.
- **No** allows reentry of the Inc value.
- **Option** displays the Options Menu again. Use the Options Menu to enter another option for the step.

### Entering an Extend Option

To enter an extend option, select Ext from the Options Menu of a temperature step, then press «Proceed». The first Ext screen will be displayed:

```
Enter: CUSTOM 1
1= 92.0  for 0:30
+ 1.2  per cycle
Sec / cycle: +_`
```

As for Inc, the temperature step being modified appears on the second line of this screen. The plus sign on the third line means that the screen is set up to enter progressive lengthening of hold time. Press «→» to switch to a minus sign, allowing entry of a progressive shortening of hold time. Press «Cancel» to change back to a plus sign.
Enter the numerical value of the increase or decrease in hold time (1.0 is used in the example below):

```
Enter: CUSTOM 1
1= 92.0 for 0:30
+1 sec/cycle
```

Press «Proceed». The Ext value just entered will move to the third line of the screen, and a confirmation menu will be displayed on the last line:

```
Enter: CUSTOM 1
1= 92.0 for 0:30
+1 sec/cycle
```

Select one of the displayed choices, then press «Proceed»:

- **Yes** accepts the Ext value and displays the Enter Menu again. Use the Enter Menu to enter the next step in the program.
- **No** allows reentry of the Ext value.
- **Option** displays the Options Menu again. Use the Options Menu to enter another option for the step.

### Entering a Beep Option

To enter a beep, select Beep from the Options Menu for a temperature step or a ramp step, then press «Proceed». The word “Beep” will be displayed on the third line of the screen, and a confirmation menu will be displayed on the last line:

```
Enter: CUSTOM 1
1= 92.0 for 0:30
Beep
```

Select one of the displayed choices, then press «Proceed»:

- **Yes** accepts the Beep option and displays the Enter Menu again. Use the Enter Menu to enter the next step in the program.
- **No** cancels the Beep option.
- **Option** displays the Options Menu again, if a temperature step is being modified. Use the Options Menu to enter another option for the step. (Option will not be displayed if a ramp step is being modified, since Beep is the only option available for ramp steps.)
Revising During Programming

To change values in a program you are entering, follow the procedures described below. This editing method should be used to change just a few values at a time. To make many changes, or to delete or add entire steps, use Edit mode (see chapter 7).

To Change the Last Value Entered or Menu Option Chosen

Press «Cancel». The choice just made will be cancelled, so that another value may be entered or another menu option chosen. Press «Proceed» after changing a value, so that the program will accept it.

To Change All the Values in the Step Being Entered

Repeatedly press «Cancel». Each time you press the key, the cursor will move backward through the values for the step, deleting the values as it moves. When all values for the step have been deleted, enter new values, or press «Cancel» one more time to display the Enter Menu for the step. At this point you can change the step to a different type.

To Change Values for Earlier Steps in the Program

Repeatedly press «Cancel» until the Enter Menu for the step you are working on is displayed. Press «Cancel» one more time to display a list of all steps entered so far. The list will show the step number and the values for each step, including any options chosen. The last-entered steps will be displayed first:

```
Enter: CUSTOM 1
3= 55.0  for 0:30
4= 72.0  for 1:00
5=
```

At this point, you can choose to change selected values in program steps, to add an option, to enter Edit mode, or to delete the entire program.

Press the «Select» keys to scroll through the program. The left «Select» key moves the cursor backward through the steps, and the right «Select» key moves it forward.

- **To change selected values or add an option:** To change a value, move the cursor to it, then press «Cancel». Enter the new value, then press «Proceed». If you change your mind, press «Cancel» again; the deleted value will be restored.
To add an option to a step, move the cursor to the step number, then press «Proceed». The Edit Menu will be displayed:

Select *Option*, then press «Proceed», and follow the procedure for adding an option. To abandon the Edit Menu and return to the list of program steps, press «Cancel».

- **To enter Edit mode:** Move the cursor to the number of the step you wish to edit, then press «Proceed». See chapter 7 for information on entering Edit mode. If you do not wish to enter Edit mode, press «Cancel». The screen will return to the list of program steps.

- **To delete the program:** Position the cursor on any step number and press «Cancel». A cancellation confirmation screen will be displayed.

Select Yes, then press «Proceed». The program will be deleted, and the Main Menu will be displayed.

**Deleting a Program**

To delete a program after at least one complete step has been entered, see “Revising During Programming,” (p. 6-18).

To delete a program before one complete step has been entered, repeatedly press «Cancel». The cursor will move backward through the step’s values, deleting them as it goes. When all values have been deleted, keep pressing «Cancel» to move backward through Enter mode screens until the Main Menu reappears, at which point you can begin a new program.

**Keeping a Permanent Record of Programs**

Occasionally in the course of repairing a defective DNA Engine cycler, it is necessary to replace the chip that stores all custom user protocols. To avoid losing your protocols in such an event, always maintain an up-to-date record of them. Protocols may be printed out using the List utility (see chapter 8), stored on a computer using the Easy Engine™ software, or written down in a notebook.
7 Editing Programs

Editing a Stored Program ........................................... 7-2
  Initiating Editing .................................................. 7-2
  Editing the Program .............................................. 7-3
    Inserting a New Step .......................................... 7-4
    Deleting a Step ................................................. 7-4
    Adding an Option .............................................. 7-4
Saving an Edited Program .......................................... 7-4
Cancelling Editing Changes ....................................... 7-5
Editing a Stored Program

The DNA Engine® cycler’s editing tools, available through Edit on the Main Menu, make it easy to extensively edit stored programs by:

- Changing individual values in program steps
- Adding new steps
- Deleting steps
- Adding options to temperature and ramp steps.

**Note:** The editing tools do not include a renaming function. To rename a program, see “Renaming a Program,” chapter 8.

Initiating Editing

To initiate editing, select Edit from the Main Menu, then press «Proceed». One of two types of screen will be displayed, depending on whether your programs have been stored in the <MAIN> folder or in custom folders.

- **If all programs have been stored in <MAIN>:**

  The screen will list the contents of <MAIN>:

  ![](Edit:_MAIN_.jpg)

  Select the program to be edited, then press «Proceed».

- **If programs have been stored in custom folders:**

  The screen will list all the folders residing in the machine:

  ![](Edit:_FOLDER1_.jpg)

  Select the folder containing the program, then press «Proceed». A list of all programs in the folder will be displayed. Select the program to be edited (CUSTOM1 is used in the following and all succeeding examples in this chapter), then press «Proceed».

  In either instance, after you press «Proceed», the first editing screen will be displayed.

4 **Tip:** To retain the original version of a program, copy the program (see “Copying a Program,” chapter 8), and then edit the copy.
Editing the Program

The first editing screen displays the two temperature control methods. The program’s current temperature control method is displayed in all-capital letters:

```
Enter: CUSTOM1
Control method:
  Block
 _CALCULATED
```

Select a different temperature control method if desired, then press «Proceed» The first three lines of the program will be displayed:

```
Edit: CUSTOM1
 _1= 92.0  for 0:10
 2= 63.0  for 1:00
 3=GoTo 1, 24 times
```

Use the «Select» keys to scroll up and down through the program. The cursor will progressively move to the step number and the individual values for each step.

To change an individual value in a step, position the cursor on it and type the new value, then press «Proceed». The new value will be displayed on the screen. To cancel a change, press «Cancel». The original value will be restored.

To add or delete a step, or to modify a step with an option, position the cursor on the step number, then press «Proceed». The Edit Menu will be displayed for that step:

```
Edit: CUSTOM1
 _1= 92.0  for 0:10
 2= 63.0  for 1:00
 3=GoTo 1, 24 times

Edit: CUSTO M1
_1= 92.0  for 0:10
2= 63.0  for 1:00
3=GoTo 1, 24 times

Option Delete
```

- **Edit** displays the previous screen again, but with the cursor positioned on the first value for the step, so that it may be changed.

- **Insert** allows a step to be added **before** the displayed step.

- **Delete** deletes the displayed step.

- **Option** allows an option to be added to the displayed step if it is a temperature or a ramp step.
Inserting a New Step

To insert a new step, select Insert from the Edit Menu, then press «Proceed». The Enter Menu will be displayed for the new step (a new step 2 is added in the example below):

```
Edit: CUSTOM1
Step 2= _TEMP GoTo
           Ramp End
```

Use the Enter Menu to create the new step (see “Entering the Program’s Steps,” chapter 6). When the step is complete, select Yes from the confirmation menu, then press «Proceed». The program being edited will be displayed again, with the new step appearing among the listed steps.

Deleting a Step

To delete a step, select Delete from the Edit Menu, then press «Proceed». The step will immediately be deleted, and the program being edited will be displayed again, minus the deleted step.

To cancel a deletion, see “Cancelling Editing Changes,” p. 7-5.

Note: Be careful when using Delete. Once a step has been deleted, it cannot be recovered without abandoning all editing changes that have been made in the program. This could be inconvenient if the program has been extensively edited.

Adding an Option

To add an option to a step, select Option from the Edit Menu, then press «Proceed». The option menu will be displayed for the step. Add the desired option to the step (see “Modifying a Program Step with the Options,” chapter 6). When the option is complete, select Yes from the confirmation menu, then press «Proceed». The steps of the program being edited will be displayed again, with the new option appearing in the list.

Saving an Edited Program

To save an edited program, use the right «Select» key to scroll to the End step of the program. Position the cursor on the number for the step, then press «Proceed». A line allowing the editing session to be ended will be displayed on the last line of the screen:
• **End** saves the changes and displays the Main Menu. This ends the editing session.
• **Insert** allows another step to be added just before the End step.

** Cancelling Editing Changes **

To cancel all editing changes made to a program, use the «Select» keys to move the cursor to any step number, then press «Cancel». A cancellation confirmation screen will be displayed:

```
Edit: CUSTOM1
Cancel changes?
  _YES  No
```

Select Yes, then press «Proceed». All editing changes will be abandoned, and the Main Menu will be displayed.
Using the Utilities

Locating a Stored Program ................................................................. 8-2

File Utilities .................................................................................. 8-2
  Creating a Folder ........................................................................ 8-3
  Assigning a Password to a Folder ................................................ 8-3
  Deleting a Folder ......................................................................... 8-4
  Copying a Program ....................................................................... 8-4
  Renaming a Program ................................................................... 8-5
  Moving a Program ........................................................................ 8-5
  Deleting a Program ...................................................................... 8-5

List Utilities ....................................................................................... 8-5
  Viewing a Program in the LCD Window ....................................... 8-6
  Printing a Program ........................................................................ 8-6

Setup Utilities ................................................................................... 8-7
  Choosing a Remote Port ............................................................... 8-7
  Choosing a Printer Port ................................................................. 8-8
  Choosing a Minimum Block Temperature for the Hot Bonnet® Lid ........................................... 8-8
  Choosing a Temperature Control Method for the Hot Bonnet Lid ........................................... 8-8
  Determining the Software Version Number ........................................ 8-9
Locating a Stored Program

Many of the DNA Engine® cycler’s utilities require you to locate a program stored in the machine. The actions necessary to do this depend on whether your programs have been stored in the <MAIN> folder or in custom folders.

- **If all programs have been stored in <MAIN>:**
  
The screen will list all the programs that <MAIN> contains:

  ![Program List](image)

  Select the desired program from this list.

- **If programs have been stored in custom folders:**
  
The screen will list all the folders residing in the machine:

  ![Folder List](image)

  Select the folder containing the program, then press «Proceed». A list of all programs in the folder will be displayed. Select the desired program, then press «Proceed».

File Utilities

Use these utilities, available from the Files Menu, to accomplish the following tasks:

- Create folders to store programs in
- Assign passwords to folders
- Copy, delete, rename, or move programs

To display the Files Menu, select Files from the Main Menu, then press «Proceed»:

![Files Menu](image)
Creating a Folder

The DNA Engine cycler’s memory can hold up to 11 folders, including the <MAIN> folder. New programs are placed in the <MAIN> folder by default unless a different folder is specified.

To create a folder, select Folder from the Files Menu, then press «Proceed». A naming screen will be displayed:

Name the folder, using the instructions found under “Naming the Program” in chapter 6, then press «Proceed». The name will be assigned to the new folder, the folder will be stored, and the Main Menu will be displayed.

Assigning a Password to a Folder

Protocols in a password-protected folder cannot be edited, renamed, or deleted, nor can new protocols be placed in the folder without the password. Users without knowledge of the password can still run, copy, and view a program.

Note: A password cannot be assigned to the <MAIN> folder.

To assign a password to a folder, select Secure from the Files Menu, then press «Proceed». A list of all folders in the machine will be displayed. Select the desired folder (other than <MAIN>), then press «Proceed». The password assignment screen will be displayed:

Valid passwords consist of numbers up to four digits long. For passwords of three digits or less, press «Proceed» after the password has been entered. Passwords four digits long will be automatically accepted as soon as typed, and the Main Menu will be displayed.

Passwords can be changed at any time. Follow the steps described above to select the desired folder, then press «Proceed». A screen asking for the old password will be displayed:

Enter the old password, then press «Proceed». The password assignment screen will be displayed. Enter the new password, then press «Proceed». The new password will be assigned to the folder, and the Main Menu will be displayed again.
Deleting a Folder

A folder must be empty before it can be deleted. After all programs have been moved or deleted from the folder, select Delete from the Files Menu, then press «Proceed». A list of all folders in the machine will be displayed. Select the folder to be deleted, then press «Proceed». A confirmation screen will be displayed:

```
Delete: <FOLDER1>
Delete empty folder?
  YES  No
```

Select Yes, then press «Proceed». The folder will be deleted, and the Main Menu will be displayed.

To cancel the deletion, press «Cancel», or select No and press «Proceed».

Copying a Program

The copy utility copies a program and gives the copy a new name. Copies can be placed in the original folder or a new one.

To copy a program, select Copy from the Files Menu, then press «Proceed». Locate the program to be copied (see “Locating a Stored Program,” p. 8-2), then press «Proceed». If more than one folder of programs is present in the machine, a screen allowing you to specify the folder the program will be copied to will be displayed:

```
Copy CUSTOM1 to:
  _<FOLDER1>  <FOLDER2>
   <FOLDER3>
```

Select a folder to copy the program to, then press «Proceed». A naming screen will be displayed:

```
Copy CUSTOM1 to:

New name: A
```

Name the copied program (see “Naming the Program,” chapter 6), then press «Proceed». The program will be copied to the specified folder under the new name, and the Main Menu will be displayed.
Renaming a Program

To rename a program, select Rename from the File Menu, then press «Proceed». Locate the program to be renamed (see “Locating a Stored Program,” p. 8-2), then press «Proceed». A naming screen will be displayed:

```
Rename: CUSTOM1
New name: A
```

Name the new program (see “Naming the Program,” chapter 6), then press «Proceed». The program will be renamed and stored, and the Main Menu will be displayed.

Moving a Program

To move a program, select Move from the Files Menu, then press «Proceed». Locate the program to be moved (see “Locating a Stored Program,” p. 8-2), then press «Proceed». A screen listing all folders will be displayed. Select the folder the program should be moved to, then press «Proceed». The program will be moved to the new folder, and the Main Menu will be displayed.

Deleting a Program

To delete a program, select Delete from the Files Menu, then press «Proceed». Locate the program to be deleted (see “Locating a Stored Program,” p. 8-2), then press «Proceed». A confirmation screen will be displayed:

```
Delete: CUSTOM3
Delete program?
_YES No
```

Select Yes, then press «Proceed». The program will be deleted, and the Main Menu will be displayed.

To cancel the deletion, press «Cancel», or select No and press «Proceed».

List Utilities

Use these utilities, available under List, to accomplish the following task:

- View and print program steps
Viewing a Program in the LCD Window

To view a program in the LCD window, select List from the Main Menu, then press «Proceed». Locate the program to be viewed (see “Locating a Stored Program,” p. 8-2), then press «Proceed». What happens next depends on whether a printer is connected to the DNA Engine cycler.

- If a printer is connected:

  A screen will be displayed asking whether the program should be sent to the printer:

  ![Print Confirmation](image)

  Select No, then press «Proceed». The program will be listed in the LCD window. The first listed screen will show the program’s control method. Press «Proceed» to view subsequent screens listing each program step, including any options. Use the «Select» keys to scroll up or down through the steps one line at a time. To return to the Main Menu, press «Cancel» at any time, or press either the right «Select» key or «Proceed» when the last step appears on the screen.

- If a printer is not connected:

  The program will immediately be listed in the LCD window. You will not be given the option of printing at all.

  **Note:** Listed programs cannot be edited. To edit programs, select Edit from the Main Menu (see chapter 7).

Printing a Program

First ensure that the DNA Engine cycler is connected to a printer. If no printer is connected, you will not be given the option of printing at all. The DNA Engine cycler’s parallel interface is compatible with most serial and laser printers, the Epson LX-810 dot-matrix printer parallel interface, and dot-matrix printers using interfaces similar to the Epson’s. Use a standard DB-25/Centronics parallel interface cable to connect the DNA Engine cycler’s parallel port to the printer’s parallel port. A null-modem serial cable will usually be required to connect the DNA Engine cycler’s serial port to a printer’s serial port.

Use the Setup utilities to choose a printer port for the DNA Engine cycler (see “Choosing a Printer Port,” p. 8-8).

Select List from the Main Menu, then press «Proceed». Locate the program to be printed (see “Locating a Stored Program,” p. 8-2), then press «Proceed». The screen asking whether the program should be sent to the printer will be displayed (see above). Select Yes, then press «Proceed». The program will be printed.
**Setup Utilities**

Use these utilities, available from the Setup Menu, to accomplish the following tasks:

- Choose a remote port and a printer port
- Choose a temperature control method for the Hot Bonnet heated lid
- Look up the DNA Engine cycler's software version number

To display the Setup Menu, select `Setup` from the Main Menu, then press «Proceed»:

```
Setup:
  _REMOTE  Printer
  Lid      Version
```

**Choosing a Remote Port**

To choose either the serial port or the IEEE-488 port, select `Remote` from the Setup Menu, then press «Proceed». The port selection screen will be displayed:

```
Remote:
  Serial  _IEEE-488
```

The cursor will be positioned at the port currently in use.

To choose the serial port, select `Serial`, then press «Proceed». The cursor will move to `Serial`, and a line allowing a baud rate to be specified will be displayed on the last line of the screen:

```
Printer:
  _SERIAL  IEEE-488
  Baud:  9600  2400_1200
```

Select a baud rate, then press «Proceed». The remote port assignment will change to serial, and the Main Menu will be displayed.

To choose the IEEE-488 port, select `IEEE-488`, then press «Proceed». The cursor will move to `IEEE-488`, and a line allowing the DNA Engine cycler to be assigned an IEEE-488 address will be displayed on the last line of the screen:

```
Printer:
  Serial  _IEEE-488
  Address (0-30):  0
```
The instrument’s current address will be displayed. To change it, enter a number from 0–30, then press «Proceed». The remote port assignment will change to IEEE-488, the address number will be assigned to the instrument, and the Main Menu will be displayed.

**Note:** Do not choose 0 for the machine address unless the DNA Engine cycler will be a controller in a network (see chapter 9).

### Choosing a Printer Port

To choose a printer port, select *Printer* from the Setup Menu, then press «Proceed». The port selection screen will be displayed:

![Printer Selection Screen]

Select the desired port, then press «Proceed». If serial was chosen, specify the printer’s baud rate as for “Choosing a Remote Port” (p. 8-7).

### Choosing a Minimum Block Temperature for the Hot Bonnet Lid

To set a minimum block temperature below which the Hot Bonnet lid will automatically turn off, select *Lid* from the Setup Menu, then press «Proceed». The following screen will be displayed:

![Lid Selection Screen]

Select «MINIMUM» and press «Proceed». The following screen will be displayed:

![Lid Minimum Selection Screen]

Use the keypad to enter the temperature, then press «Proceed» to enter the value and return to the Main Menu.

### Choosing a Temperature Control Mode for the Hot Bonnet Lid

Two temperature control modes are available for the Hot Bonnet lid:

- **Tracking:** Offsets the temperature of the heated inner lid at least a specified number of degrees Celsius in comparison to the temperature of the sample block.
• **Constant:** Keeps the inner lid at a specified temperature (°C).

The DNA Engine cycler is set for the tracking mode at the factory, using an offset of 5°C, which should be adequate for most reactions. The constant mode is provided for unusual reactions requiring the inner lid to be hot at all times. When using the constant mode, specify a lid temperature at least 10°C higher than any temperature used in the protocol; we suggest 105°C.

To choose a control mode, select *Lid* from the Setup Menu, then press «Proceed». The following screen will appear:

```
Lid:
_MODE Minimum
```

Select «Mode», then press «Proceed» (to select a minimum block temperature, see “Choosing a Minimum Block Temperature for the Hot Bonnet Lid” above).

The mode currently in use will be selected in the screen; select a different control mode if desired, then press «Proceed» to enter the mode and return to the main menu.

If the tracking mode is chosen, a lid offset (up to 45°C above the block, but not to exceed 110°C) must be specified. A line for this will appear at the bottom of the screen: “Lid offset °C: 15.” If the constant mode is chosen, a lid target temperature (up to 110°C) must be specified. A line for this will appear at the bottom of the screen: “Lid target °C: _.” In either case, enter a number, then press «Proceed». The tracking control mode will be implemented, and the Main Menu will be displayed.

## Determining the Software Version Number

At times it is necessary to determine the version number of the software installed in the DNA Engine cycler (e.g., to report a problem to Bio-Rad). To do this, select *Version* from the Setup Menu, then press «Proceed». The current version number will be displayed:

```
Version: 1.1L
CTRL L EXEC L
USER L COMM L
```

The top line reports the software version number (1.1L in the example). The other two lines refer to the four “pages” that the software has been broken into and their associated versions (L in the example).

Bio-Rad periodically updates the DNA Engine cycler software to incorporate new features or allow new Alpha™ units to be used. Most upgrades are available free of charge for units under warranty and may be installed into a DNA Engine cycler electronically from a desktop computer. Contact your Bio-Rad sales representative or an authorized distributor for details. Occasionally upgrades may require a hardware change. These upgrades require return of the DNA Engine base to Bio-Rad or an authorized distributor.
Networking

Overview of Networking .................................................. 9-2
Networking Instruments without a Computer ......................... 9-2
  Connecting the Instruments .......................................... 9-2
  Assigning Address Numbers to Instruments ....................... 9-2
  Running a Protocol on Networked Instruments .................... 9-3
Networking Instruments with a Computer .......................... 9-4
  Creating a Computer-Controlled IEEE-488 Network .............. 9-5
  Creating a Computer-Controlled RS-232 Network ................. 9-5
Overview of Networking

Up to 15 instruments consisting of any combination of DNA Engine® (or DNA Engine Tetrad®) cyclers may be networked, with or without a computer as the controller. When networking with a computer, all the instruments are controlled from the computer’s keyboard. When networking without a computer, a specially designated DNA Engine cycler controls the other instruments in the network. Any combination of single- and dual-block Alpha™ units may be loaded into networked instruments, and different protocols can be run independently on them.

Networked instruments can help save time for a busy laboratory. For example, in a DNA Engine cycler–controlled network, protocols can be entered into the controlling instrument and then be run on all the other instruments connected to the network.

Networking Instruments without a Computer

Connecting the Instruments

Connect DNA Engine and DNA Engine Tetrad cyclers via the IEEE-488 port on the back of each instrument (see figs. 2-3 and 12-4), using high-quality cables. Although several connection configurations are possible, we recommend a simple daisy chain or star pattern. The DNA Engine cycler’s IEEE-488 interface is fully compatible with both the IEEE-488.2 and the IEEE-488.1 standards.

Assigning Address Numbers to Instruments

Each instrument must have a unique address number, which is assigned from its control panel. Address numbers cannot be assigned from the controller.

To assign an address number to an instrument, select Setup from the Main Menu, then press «Proceed». The Setup Menu will be displayed:

```
Setup: _REMOTE Printer
       Lid   Version
```

Select Remote, then press «Proceed». A screen allowing choice of a port will be displayed:

```
Remote: _SERIAL IEEE-48
```
Select IEEE-488, then press «Proceed». The remote addressing screen will be displayed:

<table>
<thead>
<tr>
<th>Remote:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial _IEEE-488</td>
</tr>
<tr>
<td>Address (0-30): 0</td>
</tr>
</tbody>
</table>

Enter an address number for the instrument. Set the controller DNA Engine cycler’s address to 0. Give the other instruments in the network any number from 1 to 30. Press «Cancel» to delete a number and enter a new one.

### Running a Protocol on Networked Instruments

To run a protocol on networked instruments, use the controller to select a protocol (see “Choosing a Stored Protocol to Run,” chapter 5), then press «Proceed». The network screen for the controller will be displayed:

<table>
<thead>
<tr>
<th>Run: 2-STEP on *</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block: Local (96V)</td>
</tr>
</tbody>
</table>

The protocol will be identified on the top line (2-STEP in the example above). The single asterisk in the upper right-hand corner indicates that a single-block Alpha unit is loaded into the controller. “Local” indicates that this is the controller’s network screen, and “96V” indicates the type of Alpha unit loaded into the controller.

If a Dual Alpha™ unit is loaded into the controller, press «Proceed» until the letter designating the desired block is displayed after the asterisk in the upper right-hand corner of the screen. The letter A designates the right-hand block, and the letter B the left-hand one (e.g., *A, *B).

To run the protocol on the controller’s block, press «Proceed». One or more screens for setting up the protocol's temperature control method will be displayed (see “Running a Protocol,” chapter 5). When these screens have been worked through, the protocol will begin running.

To run the protocol on a different instrument’s block, press «Block» until the screen identifies the desired block (22 in the example below):

<table>
<thead>
<tr>
<th>Run: 2-STEP on 22</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block: Remote 60V</td>
</tr>
</tbody>
</table>

The instrument’s address number will be identified in the upper right-hand corner of the screen. “Remote” indicates that this is the network screen for a slave unit, and “60V” indicates the type of Alpha unit that has been selected. The status light for the selected block will flash on the control panel of the instrument holding the block.
If the right or left block of a dual-block Alpha unit has been selected, an A or B will appear after the address number (e.g., 7-3A for the right-hand block in a Dual Alpha unit loaded into quadrant 3 of a DNA Engine Tetrad at address 7. See figure 12-1 for a diagram of the layout of quadrants in the DNA Engine Tetrad cycler).

Press «Cancel» at any time to abandon the selection process and display the Main Menu again.

When the desired block is identified in the LCD window, press «Proceed». When you have worked through the screens that set up the protocol’s temperature control method, the protocol will begin running.

The protocol’s runtime screen will appear on the controller's LCD window. The LCD window of the instrument holding the active block will continue to show whatever screen it was displaying before the protocol began running.

Press «Block» to display the Main Menu on the controller again. Repeat the procedure to run protocols on other networked blocks. Press «Block» on the controller to progressively display the runtime screens of all networked blocks that are running protocols.

While protocols are running, other DNA Engine cycler functions (Edit, Enter, Files, etc.) can be accessed on any individual instrument in the network, from that instrument's front panel.

**Networking Instruments with a Computer**

For users who wish to write their own software interface for computer control of Bio-Rad DNA Engine® line thermal cyclers, including the DNA Engine (PTC-0200), Bio-Rad provides a set of ASCII commands, or Remote Command Sets, for communication with the cyclers. These may be downloaded from www.bio-rad.com, or obtained from Bio-Rad Technical Support. A computer-controlled network can be connected via IEEE-488 cables or RS-232 (serial) cables. In either case, the computer acts as the controller of the network and uses the driver software to communicate with the networked instruments.

**Establishing Communication Using the Remote Interfaces**

The DNA Engine remote control interface is based on the IEEE-488.2 standard. The GPIB interface is fully compatible with both this standard and the IEEE-488.1 hardware standard.

The serial remote interface uses an identical command set which includes the IEEE-488.2 required common commands. On a DNA Engine, multiple commands or queries may be contained in one message as long as they are separated by semicolons. Corresponding responses to any queries will be returned in a single message, also separated by semicolons.
The IEEE-488 GPIB Remote Interface

To connect DNA Engine (and DNA Engine Tetrad) cyclers in a computer-controlled IEEE-488 network, the computer must be equipped with an IEEE-488 (GPIB) interface card. Connect the instruments and assign addresses as described under “Networking Instruments Without a Computer” (p. 9-2). Make sure that none of the networked instruments have been assigned IEEE-488 address 0 as this address is reserved for a DNA Engine acting as system controller and will cause communication problems with the computer.

All inputs (commands or queries) to the unit must be terminated with a NEWLINE character (ASCII 10), an ^END hardware level command on the last data byte of the message, or a NEWLINE^END combination following the last data byte of the message. The preferred terminator is the NEWLINE^END combination. All outputs from the unit (query responses) are terminated with a NEWLINE^END.

The RS-232 Serial Remote Interface

In a computer-controlled RS-232 (serial) network, each instrument in the network is connected directly to the controlling computer via a serial port. The number of instruments that can be included in such a network thus depends on the number of serial ports available on the controlling computer. Use high-quality null modem serial cables to connect the serial port on each instrument (see figs. 2-3 and 12-4) to a serial port on the computer.

Use the Setup utilities to configure each instrument for serial communications (see “Choosing a Remote Port,” chapter 8, and select the serial port and the 9600 baud rate). The Port Settings should also specify 8-bit data bytes, 1 stop bit, and no parity.

All inputs to the unit must be terminated with a NEWLINE (ASCII 10). Each output from the DNA Engine is terminated with a RETURN (ASCII 13) NEWLINE combination.
10 Maintenance

Cleaning the DNA Engine Cycler ......................................................... 10-2
  Cleaning the Chassis and Block ............................................... 10-2
  Cleaning the Air Vents ................................................................. 8-3
  Cleaning Radioactive or Biohazardous Materials out of the Block .... 10-3

Changing the Fuses ................................................................. 10-3
Cleaning the DNA Engine® Cycler

Cleaning the Chassis and Block

Clean the outside of the DNA Engine cycler and Alpha™ unit with a damp, soft cloth or tissue whenever something has been spilled on it or the chassis is dusty. A mild soap solution may be used if needed.

Clean block wells with swabs moistened with water, 95% ethanol, or a 1:100 dilution of bleach in water (see the Slide Chambers Alpha Unit Operations Manual for instructions on cleaning the Slide Chambers™ Alpha unit’s slide slots). If using bleach, swab wells with water afterward to remove all traces of bleach. Clean spilled liquids out of the block as soon as possible; dried fluids can be difficult to remove. Do not clean the block with caustic or strongly alkaline solutions (e.g., strong soaps, ammonia, bleach at a higher concentration than specified above). These will damage the block’s protective anodized coating, possibly causing electrical shorting.

If you use oil in the block (a practice not recommended by Bio-Rad; see “Using Oil to Thermally Couple Sample Vessels to the Block,” chapter 4), clean the wells whenever the oil has become discolored or contains particulate matter. Use a swab to determine whether cleaning is needed. Clean the block with 95% ethanol as described above. **Oil buildup must be prevented.** Old oil harbors dirt, which interferes with vessel seating and diminishes thermal coupling of sample vessels to the block.

**Caution:** Do not pour any cleaning solution into the block’s wells and then heat the block, in an attempt to clean it. Severe damage to the block, the heated lid, and the chassis will result.

Cleaning the Air Vents

Clean the air intake and exhaust vents with a soft-bristle brush, a damp cloth, or a vacuum cleaner whenever dust is visible in them. The air intake vents are located on the bottom, lower front edge, and back of the machine; the air exhaust vents are located on both sides (see figs. 2-1, 2-3, and 2-4). If these vents become clogged with dust and debris, airflow to the Alpha unit’s heat sink is hampered, causing performance problems related to overheating. The air intake vents are particularly likely to collect dust since their holes are much smaller than those of the air exhaust vents.

Tip: To prevent problems with overheating, institute a regular program of checking for dust buildup, particularly for robotics installations.
Cleaning Radioactive or Biohazardous Materials out of the Block

When cleaning instruments that have been running radioactive or biohazardous reactions, consult your institution’s radiation safety officer or biosafety officer regarding cleaning methods, monitoring, and disposing of contaminated materials.

Changing the Fuses

The circuits in the DNA Engine cycler are protected by two fuses (6.3A fast-acting, 5x20mm). When a fuse blows, the DNA Engine cycler immediately shuts down and cannot be turned back on. The machine records the event as a power loss, so if a protocol is running when a fuse blows, the machine will resume the run when the fuse is replaced and power restored (see “Resuming a Protocol after a Power Outage,” chapter 5).

**Warning:** The DNA Engine cycler incorporates neutral fusing, which means that live power may still be available inside the unit even when a fuse has blown or been removed. Never open the DNA Engine base. You could receive a serious electrical shock. Opening the base will also void your warranty.

1. Disconnect the power cord from the back of the instrument. Move the power switch to the “0” (off) position.

2. Insert one corner of a small flat-head screwdriver just under the fuse plug (fig. 10-1A), and gently pry the plug loose. Pull the plug straight out as far as it will go, then push it downward to expose the fuses (fig. 10-2B).

3. Remove both fuses and replace them with new ones (it is impossible to visually determine which fuse is blown). You may also test the fuses with an ohmmeter to determine which is defective and replace just that one.

4. Gently press the fuse cover back in place, and reconnect the power cord.

---

**Figure 10-1**  A, Removing the fuse plug.  B, Location of the fuses in the opened plug.
## Error Messages

**Note:** The DNA Engine® and DNA Engine Tetrad® software is highly sensitive with respect to block and heat-sink errors. When such errors messages occur, try restarting the protocol. If the message fails to reappear, proceed as usual.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A / C Power Failed, Cycle XXX Step X, Recovered at XX.X°</td>
<td>Displayed when a machine running a protocol has been turned off, either intentionally or due to a power outage, and then turned on again.</td>
<td>No action is necessary. Protocol resumes running when power is restored. Results may or may not be affected, depending on whether power failed in an early or a late cycle, and whether the power was restored before the sample cooled excessively.</td>
</tr>
<tr>
<td>Block Overheated, Return for Service</td>
<td>Displayed when a machine running a protocol has been turned off, either intentionally or due to a power outage, and then turned on again.</td>
<td>Alpha unit and/or base needs servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Block Sensor Fault, Left Ignored (Center Ignored, Right Ignored)</td>
<td>Left, center, or right temperature sensor in Alpha unit is not working properly, so machine is now ignoring it and relying on remaining sensors to monitor block temperature.</td>
<td>Alpha unit needs servicing soon. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Block Sensor Fault, Program Terminated.</td>
<td>None of the temperature sensors in Alpha unit are working properly, so Alpha unit has been shutdown.</td>
<td>Alpha unit and/or base needs servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Cause and Result</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calc Control, Probe Mode Invalid</td>
<td>Runtime error indicating a gradient step is being programmed under Probe Control mode.</td>
<td>Change to Calc control mode.</td>
</tr>
<tr>
<td>Gradient Fault, Service Alpha soon.</td>
<td>Displayed at end of run. Indicates gradient was not achieved within 20 sec of block reaching target.</td>
<td>Alpha unit and / or base needs servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Gradient Program, Invalid Alpha Type.</td>
<td>Runtime error indicating gradient is being programmed for an Alpha module other than a 96V.</td>
<td>Use 96V Alpha module.</td>
</tr>
<tr>
<td>Heated Lid Fault, Program Terminated.</td>
<td>Lid sensor failed during preheat, so Alpha unit has been shut down.</td>
<td>Heated lid or base needs servicing Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>HS Overheated, Program Terminated</td>
<td>Machines are not getting enough air, or air being taken in is warmer than 31°C.</td>
<td>Make sure machine gets enough air and that temperature of air being taken in is 31°C or cooler (see p. 3-3). Correct air supply problems and run protocol again. If error message persists, base may need servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td></td>
<td>Machine is running a protocol consisting of many cycles of only a few seconds each. Alpha unit heat sink does not have time to dissipate heat generated by rapid cycling. Eventually its maximum allowable temperature is exceeded, and Alpha unit is shut down.</td>
<td>Contact Bio-Rad or your local distributor to discuss protocol.</td>
</tr>
<tr>
<td></td>
<td>Sensor malfunction has allowed base to heat block over its maximum allowable temperature (107.5°C), triggering automatic Alpha unit shutdown.</td>
<td>Alpha unit and / or base needs servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>HS Overheating, Check Air Flow</td>
<td>See causes for “HS Overheated, Program Terminated.”</td>
<td>See actions for “HS Overheated, Program Terminated.”</td>
</tr>
<tr>
<td>HS/PS Sensor Fault, Program Terminated.</td>
<td>Heat sink sensor in Alpha unit and power supply sensor in base are not working, so Alpha unit has been shut down.</td>
<td>Alpha unit or base needs servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Cause and Result</td>
<td>Action</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HS Sensor Fault, Alt Control Mode</td>
<td>Alpha unit heat sink sensor is not functioning properly, so machine has begun estimating heat sink temperature based on other temperature sensor readings.</td>
<td>Alpha unit needs servicing soon. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>HS Sensor Fault, Left Ignored.</td>
<td>Same as previous</td>
<td>Same as previous</td>
</tr>
<tr>
<td>HS Sensor Fault, Right Ignored.</td>
<td>Same as previous</td>
<td>Same as previous</td>
</tr>
<tr>
<td>Internal Fan Fault, Return for Service</td>
<td>Fan inside base is not working, so Alpha unit has been shut down.</td>
<td>Fan must be repaired. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Lid Sensor Fault, Lid Was Disabled.</td>
<td>Heated lid is giving unexpected temperature readings, so base has turned it off. Protocols can still be run, but reactions may fail because of condensation in vessels.</td>
<td>Alpha unit needs servicing soon. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>L/R Power Imbalance</td>
<td>Thermoelectric units in Alpha unit block are not heating uniformly, so machine begins delivering equal power to all heating elements. Protocols may still be run, but reactions may fail due to uneven block temperatures.</td>
<td>Alpha unit needs servicing soon. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Memory Is Corrupt!</td>
<td>Rarely seen message indicating that memory has been corrupted by a static shock or other unusual electronic incident.</td>
<td>Base needs servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>No Memory Available!</td>
<td>All available memory has been filled.</td>
<td>Delete unused protocols and folders from memory. Reduce size of stored programs by using GoTo and the Inc and Ext options (see chapter 6).</td>
</tr>
<tr>
<td>Probe Sensor Fault, Used Calc Control</td>
<td>Either probe sensor is not working properly or a probe-control protocol was run without probe being installed. Machine has switched temperature control method to calculated control.</td>
<td>Make sure probe is installed when running probe-control programs. If error message persists, replace probe.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Cause and Result</td>
<td>Action</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PS Overheated, Program Terminated</td>
<td>Machine is not getting enough air, or air being taken in is warmer than 31°C.</td>
<td>Make sure that machine is getting enough air and that temperature of air being taken in is 31°C or cooler (see p. 3-3). Correct any air supply problems and run protocol again. If error message persists, base may need servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>PS Overheating, Check Air Flow</td>
<td>Machine is running a protocol consisting of many cycles of only a few seconds each. Alpha unit heat sink does not have time to dissipate heat generated by rapid cycling. Eventually its maximum allowable temperature is exceeded, and Alpha unit is shut down.</td>
<td>Contact Bio-Rad or your local distributor to discuss protocol.</td>
</tr>
<tr>
<td>PS Sensor Fault, Temp Ignored</td>
<td>Power supply sensor is not working properly. Protocols can still be run, but machine should be serviced soon to repair sensor.</td>
<td>Base needs servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Slow Block Cycling, Service Alpha Soon</td>
<td>Alpha unit block has not reached target temperature within expected time. Unit will begin beeping, and will continue to beep until target temperature is reached, protocol is manually progressed to its next step (see p.5-8), or protocol run is halted. Problem often results from machine not getting enough air, or taking air that is warmer than 31°C.</td>
<td>Make sure that machine is getting enough air and that temperature of air being taken in is 31°C or cooler (see p. 3-3). Correct any air supply problems and run protocol again. If error message persists, software upgrade may be needed or base may need servicing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Slow Lid Cycling, Service Alpha Soon</td>
<td>Alpha unit lid has not reached target temperature within expected time. Unit will begin beeping, and will continue to beep until target temperature is reached, protocol is manually progressed to its next step (see p.5-8), or protocol run is halted.</td>
<td>Alpha unit lid needs servicing soon. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td>Unit Failure/Unit X Failure (Tetrad)</td>
<td>The self-test has failed because of a problem with the base or the Alpha unit.</td>
<td>Contact Bio-Rad or your local distributor.</td>
</tr>
</tbody>
</table>
Problems Related to Protocols

Following is a general description of some common problems related to the protocols and reaction components in sequencing and amplification applications. For a more detailed discussion of protocols and reactions, see Current Protocols in Molecular Biology (F. Ausubel et al., eds., John Wiley & Sons), specifically chapters 7 (DNA sequencing), 14 (in-situ hybridization and immunology), and 15 (polymerase chain reaction).

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause and Result</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reaction is working, but broad low-molecular weight band is seen in gels.</td>
<td>“Primer-dimer” material often produces a broad band in the &lt;100 bp region of gels.</td>
<td>If obtaining appropriate reaction product/s, no need to change anything.</td>
</tr>
<tr>
<td>Minimize “primer-dimer” production by designing primers with no 3’ self-complementary.</td>
<td>Reoptimize magnesium concentration and annealing temperature to maximize desired product and minimize “primer-dimers”.</td>
<td></td>
</tr>
<tr>
<td>Reaction working, but unexpected extra products or smear is seen.</td>
<td>Nonspecific hybridization occurring during setup.</td>
<td>Program a hot start into the protocol.</td>
</tr>
<tr>
<td>Reaction component concentration too high or too low.</td>
<td>Check concentrations of components. May need to reoptimize magnesium concentration.</td>
<td></td>
</tr>
<tr>
<td>Annealing temperature too low.</td>
<td>Reoptimize annealing temperature.</td>
<td></td>
</tr>
<tr>
<td>Protocol contains a wrong value.</td>
<td>Use List utility to check protocol’s temperature control method, temperatures, and times.</td>
<td></td>
</tr>
<tr>
<td>Template not of sufficient purity.</td>
<td>Check extraction and purification protocols. Add additional purification steps if necessary.</td>
<td></td>
</tr>
<tr>
<td>Multiple templates or host DNA in sequencing reactions.</td>
<td>Check nucleic acid preparations by gel electrophoresis.</td>
<td></td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No reaction products obtained.</td>
<td>Wrong protocol used.</td>
<td>Re-run reaction using correct protocol.</td>
</tr>
<tr>
<td></td>
<td>Protocol contains a wrong value.</td>
<td>Use List utility to check protocol’s temperature control method, temperatures, and times.</td>
</tr>
<tr>
<td></td>
<td>Reaction component omitted from mixture.</td>
<td>Check reaction assembly protocol, ensuring that mixture contains appropriate components in correct concentrations.</td>
</tr>
<tr>
<td></td>
<td>Denaturation temperature too low.</td>
<td>Use $\geq 92^\circ C$ for denaturation.</td>
</tr>
<tr>
<td></td>
<td>Annealing temperature too high for primers.</td>
<td>Check for appropriate annealing temperatures of primers, using available computer programs or empirical testing.</td>
</tr>
<tr>
<td></td>
<td>Wrong temperature control method used.</td>
<td>Use List utility to check temperature control method for protocol; change if needed.</td>
</tr>
<tr>
<td></td>
<td>Probe failed, causing machine to run protocol under calculated control.</td>
<td>Check screen for probe failure error message. Probe may need servicing or replacing. Contact Bio-Rad or your local distributor.</td>
</tr>
<tr>
<td></td>
<td>Probe not filled with correct amount of oil.</td>
<td>Fill probe tube with correct amount of oil. (see p. 4-11).</td>
</tr>
<tr>
<td></td>
<td>Reaction mix contains an inhibitor (e.g., heme from blood).</td>
<td>Spike a complete reaction mix with a control template and primer set.</td>
</tr>
<tr>
<td></td>
<td>Reaction vessels not making good thermal contact with sample block.</td>
<td>Use only high-quality tubes/plates that fit block snugly. Ensure that wells are free of foreign materials that would interfere with tube/plate seating.</td>
</tr>
</tbody>
</table>
# Problems Related to Environmental Conditions, Setup, and Maintenance

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequent shutdowns due to overheating.</td>
<td>Machine is not receiving enough air.</td>
<td>Make sure air intake vents are not obstructed by dust, debris, or paper. Remove light collections of dust and debris with damp cloth. Vacuum out heavy collections. Remove any papers placed under the machine at least 10cm from vertical surfaces.</td>
</tr>
<tr>
<td>Frequent “Slow Block Cycling,” and “HS Overheating” error messages.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Air flowing into vents is not $\leq 31^\circ C$.</td>
<td></td>
<td>Check temperature of air entering air intake vents, following procedure on p. 3-3. If higher than 31°C, use table 3-1 to troubleshoot and remove cause / s.</td>
</tr>
<tr>
<td>Dust and debris clogging up air intake vents.</td>
<td>Failure to regularly check for buildup.</td>
<td>Remove light collections damp cloth. Vacuum out heavy collections.</td>
</tr>
</tbody>
</table>
Appendix A: Warranty Information

The DNA Engine® (PTC-0200) thermal cycler is warranted against defects in materials and workmanship. For specific warranty information, contact your local Bio-Rad office. If any defects should occur during the warranty period, Bio-Rad will replace the defective parts without charge. However, the following defects are specifically excluded:

1. Defects caused by improper operation or by improper packaging of returned goods.
2. Repair or modifications done by anyone other than Bio-Rad Laboratories.
3. Use with tubes, plates, or sealing materials not specified by Bio-Rad Laboratories for use with the DNA Engine thermal cycler.
4. Deliberate or accidental misuse.
5. Damage caused by disaster.
6. Damage due to use of improper solvent or sample.

The warranty does not apply to fuses.

For inquiry or request for repair service, contact Bio-Rad Laboratories after confirming the model and serial number of your instrument.
### Appendix B: Factory-Installed Protocols

2-step Fast PCR protocol using iTaq™ polymerase

<table>
<thead>
<tr>
<th>iTAQ-FST</th>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>98</td>
<td></td>
<td>:30</td>
</tr>
<tr>
<td>2</td>
<td>92</td>
<td></td>
<td>:01</td>
</tr>
<tr>
<td>3</td>
<td>70</td>
<td></td>
<td>:10</td>
</tr>
<tr>
<td>4</td>
<td>GOTO</td>
<td>2, 34X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>72</td>
<td></td>
<td>:15</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td>END</td>
</tr>
</tbody>
</table>

2-step PCR protocol using iProof™ high-fidelity polymerase for small, intermediate, and long templates

#### iPRF1kb

<table>
<thead>
<tr>
<th>iPRF1kb</th>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>2:00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:05</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>72</td>
<td>:30</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>GOTO</td>
<td>2, 219X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>72</td>
<td>10:00</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>

#### iPRF8kb

<table>
<thead>
<tr>
<th>iPRF8kb</th>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>2:00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:05</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>72</td>
<td>4:00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>GOTO</td>
<td>2, 19X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>72</td>
<td>10:00</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>

#### iPRF15kb

<table>
<thead>
<tr>
<th>iPRF15kb</th>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>2:00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:05</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>72</td>
<td>4:00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>GOTO</td>
<td>2, 19X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>72</td>
<td>10:00</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>

### Standard 2-step PCR protocol

#### STD-2

<table>
<thead>
<tr>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>4:00</td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>3</td>
<td>65</td>
<td>:30</td>
</tr>
<tr>
<td>4</td>
<td>GOTO</td>
<td>2, 29X</td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>END</td>
</tr>
</tbody>
</table>

### Standard 3-step PCR protocol

#### STD-3

<table>
<thead>
<tr>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>4:00</td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>3</td>
<td>55</td>
<td>:30</td>
</tr>
<tr>
<td>4</td>
<td>72</td>
<td>:30</td>
</tr>
<tr>
<td>5</td>
<td>GOTO</td>
<td>2, 29X</td>
</tr>
<tr>
<td>6</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>7</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>END</td>
</tr>
</tbody>
</table>

### Touchdown PCR protocol

#### TCHDOWN

<table>
<thead>
<tr>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>4:00</td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>3</td>
<td>60</td>
<td>:30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Increment -0.5°C/cycle)</td>
</tr>
<tr>
<td>4</td>
<td>72</td>
<td>:30</td>
</tr>
<tr>
<td>5</td>
<td>GOTO</td>
<td>2, 29X</td>
</tr>
<tr>
<td>6</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>7</td>
<td>45</td>
<td>:30</td>
</tr>
<tr>
<td>8</td>
<td>72</td>
<td>30</td>
</tr>
<tr>
<td>9</td>
<td>GOTO</td>
<td>6, 29X</td>
</tr>
<tr>
<td>10</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>11</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>END</td>
</tr>
</tbody>
</table>
### 2-step RT PCR protocol

**RTPCR-2**

<table>
<thead>
<tr>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>37</td>
<td>60:00</td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>5:00</td>
</tr>
<tr>
<td>3</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>4</td>
<td>65</td>
<td>:30</td>
</tr>
<tr>
<td>5</td>
<td>GOTO 3, 39X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>7</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>

### 3-step RT PCR protocol

**RTPCR-3**

<table>
<thead>
<tr>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>37</td>
<td>60:00</td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>5:00</td>
</tr>
<tr>
<td>3</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>4</td>
<td>55</td>
<td>:30</td>
</tr>
<tr>
<td>5</td>
<td>72</td>
<td>:30</td>
</tr>
<tr>
<td>6</td>
<td>GOTO 3, 39X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>8</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>

### 2-step nested primer protocol

**NEST PR2**

<table>
<thead>
<tr>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>4:00</td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>3</td>
<td>65</td>
<td>:30</td>
</tr>
<tr>
<td>4</td>
<td>GOTO 2, 39X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>6</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>8</td>
<td>65</td>
<td>:30</td>
</tr>
<tr>
<td>9</td>
<td>GOTO 7, 39X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>11</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>

### 3-step nested primer protocol

**NEST PR3**

<table>
<thead>
<tr>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>4:00</td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>3</td>
<td>55</td>
<td>:30</td>
</tr>
<tr>
<td>4</td>
<td>72</td>
<td>:30</td>
</tr>
<tr>
<td>5</td>
<td>GOTO 2, 39X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>7</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>9</td>
<td>55</td>
<td>:30</td>
</tr>
<tr>
<td>10</td>
<td>72</td>
<td>:30</td>
</tr>
<tr>
<td>11</td>
<td>GOTO 8, 39X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>13</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>

### 2-step long PCR protocol using iTaq polymerase

**LONG-2**

<table>
<thead>
<tr>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>4:00</td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>3</td>
<td>65</td>
<td>3:00 Ext 15s/cycle</td>
</tr>
<tr>
<td>4</td>
<td>GOTO 2, 34X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>6</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>

### 3-step long PCR protocol using iTaq polymerase

**LONG-3**

<table>
<thead>
<tr>
<th>Step</th>
<th>Temp</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>95</td>
<td>4:00</td>
</tr>
<tr>
<td>2</td>
<td>95</td>
<td>:30</td>
</tr>
<tr>
<td>3</td>
<td>55</td>
<td>:30</td>
</tr>
<tr>
<td>4</td>
<td>72</td>
<td>3:00 Ext 15s/cycle</td>
</tr>
<tr>
<td>5</td>
<td>GOTO 2, 34X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>72</td>
<td>7:00</td>
</tr>
<tr>
<td>7</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>
Index

A
Air supply requirements
  ensuring adequate air supply  3-3
  ensuring air is cool enough  3-4
  troubleshooting problems with  3-4
Alpha units
  closing  4-5
  installing  4-4
  models  2-4
  opening  4-5
  removing  4-5
B
Baud rate, setting  8-7
Beep option. See Programs: options, types of
Bleach, using in block  10-2
C
Chill-out liquid wax  4-7
Cleaning
  air vents  10-2
  and biohazardous materials  10-3
  and radioactive materials  10-3, 4-13
  chassis and block 10-2
  removing oil from block  10-2
  solutions to use  4-13
Condensation in tubes following holds  4-7
Control panel  2-2
keys 4-3
lights 4-3
using 4-3

D
Documentation conventions
  graphic vi
  terminology vi
  typographic vi

E
Electromagnetic interference v
Environmental requirements 3-2–3-3
Error messages 11-2
Explanation of symbols iv
Extend option. See Programs: options, types of

F
FCC warning v
Fuses
  changing 10-3

H
Hot Bonnet lid
  adjusting lid pressure 4-8–4-9
  temperature control methods 8-8

I
Increment option. See Programs: options, types of
Instant incubation 5-9

L
Layout
  back view 2-3
  bottom view 2-3
  control panel 2-2
front view 2-2

M
Menus
Edit Menu 7-2
   Enter Menu 6-5
   Files Menu 8-2
   Main Menu 4-2
   Options Menu 6-5
   Setup Menu 8-7
Microseal
   ’A’ film 4-8
   ’B’ adhesive seals 4-8
   ’F’ foil 4-8
   ’P’/’P+’ pads 4-8
Moto Alpha unit 2-4

N
Networking
   general information 9-2
   with computer as controller 9-4
      setting up an IEEE-488 network 9-5
      setting up an RS-232 network 9-5
   with DNA Engine cycler as controller 9-2
      assigning address numbers 9-2
      connecting machines 9-2
      running protocols 9-3

O
Oil, use of in block. See Sample vessels

Operation
   turning machine on 4-2

P
Packing checklist 3-2
Passwords. See Utilities: files: assigning password to folder

Ports  2-5, 4-3
   IEEE-488  2-3
   parallel (printer)  2-3
   RS-232  2-3

Power cord
   location of jack  2-3
   plugging in  3-2

Power supply requirements  3-3
   acceptable power cords  3-3

Programming
   choosing a temperature control method  6-6
   deleting a program  6-19

   entering steps
      beep option  6-17
      end step  6-14
      extend option  6-16
      GoTo step  6-13
      gradient step  6-8
      increment option  6-15
      ramp step  6-12
      temperature step  6-7

   general process  6-5
   initiating a program  6-5
   modifying block--control programs  6-5
   modifying programs designed for other machines  6-5
   naming a program  6-6
   setting a lengthy hold time  6-8

Programs
   designing  6-2–6-5
      choosing temperature control method. See Temperature control methods
      translating protocol into programs  6-3
using GoTo steps to shorten programs 6-3

editing 7-2, 7-3
  adding an option 7-4
  cancelling editing changes 7-5
  deleting step 7-4
  inserting new step 7-4
  saving edited program 7-4

finding in machine 5-2, 7-2, 8-2
options, types of 6-2, 6-15
program steps, types of 6-2
renaming. See Utilities: file

Protocols
  and power failure 5-8
factory-installed 5-2, B-1
manually stepping through 5-7
pausing while running 5-7
printing logs for runs 5-6–5-7
running
  choosing block to run protocol on 5-3
  choosing protocol to run 5-2
  reading completion screen 5-6
  reading runtime screen 5-5
  setting up temperature control method 5-3
  three steps of 5-2
  stopping while running 5-8

protocols
  adjusting for sample vessel type 4-6

S
Safety
  general instructions 1-3
  guideline for safe use v
  warnings iv
Sample vessel
   selection chart  4-11
Sample vessels
   ensuring good thermal contact  4-10
   loading into block  4-9
   sealing
      reason for  4-7
      with Hot Bonnet lid and caps/film  4-7
      with oil or wax  4-7
   selection  4-6
      0.2 ml tubes  4-6
      0.5 ml tubes  4-6
      microplates  4-6
   use of oil to improve thermal contact with block  4-10
Self-test  4-2
Setting machine up. See also Alpha units, installing
Shipping instructions A-1
Specifications  2-5

T
Temperature control methods
   block control  6-4
   calculated control  6-4

U
Utilities
   file
      assigning password to folder  8-3
      copying program  8-4
      creating folder  8-3
      deleting a program  8-5
      deleting folder  8-4
      moving a program  8-5
printing a program  8-6
renaming programs  8-5
viewing a program in LCD window  8-6
setup  8-7
  choosing a printer port  8-8
  choosing a remote port  8-7
  choosing a temperature control method for the Hot Bonnet lid  8-8
determining software version number  8-9

W
Warranty information  A-1
Declaration of Conformity

Bio-Rad Laboratories, Inc., 1000 Alfred Nobel Drive, Hercules, California, 94547, U.S.A., declares that the product

PTC0200, The DNA Engine® Thermal Cycler

to which this declaration relates, is in conformity to the following standards or normative documents.

IEC61010-1
EN61326: CLASS A


This product is imported into the EU by Bio-Rad Laboratories, Ltd., Bio-Rad House, Maxted Road, Hemel Hempstead (London area), Hertfordshire HP2 7DX England.

13 September, 2004
date of issue

Brad Crutchfield
Vice President
Technical Service:

Call your local Bio-Rad office, or in the U.S. call 1-800-4BIORAD (1-800-424-6723).